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FOREWORD
Thank you for purchasing this Icom product. The ID-1 DIGITAL

TRANSCEIVER is designed and built with Icom’s superior tech-
nology and craftsmanship. With proper care, this product
should provide you with years of trouble-free operation.

We want to take a couple of moments of your time to thank
you for making your ID-1 your radio of choice, and hope you
agree with Icom’s philosophy of “technology first.” Many hours
of research and development went into the design of your 
ID-1.

DD FEATURES

❍ Current FM, Digital Voice and Data modes
available

❍ Standard PC control application via USB
terminal connection

❍ Remote controller for current mobile trans-
ceiver style operation (optional for some versions)

❍ Standard 10BASE-T connector for data
transmission/reception

IMPORTANT
READ ALL INSTRUCTIONS carefully and completely
before using the transceiver.

SAVE THIS INSTRUCTION MANUAL— This in-
struction manual contains important operating instructions for
the ID-1.

EXPLICIT DEFINITIONS

WORD DEFINITION

R WARNING!

CAUTION

NOTE

Personal injury, fire hazard or electric shock
may occur.

Equipment damage may occur.

Recommended for optimum use. No risk of
personal injury, fire or electric shock.

Icom, Icom Inc. and the logo are registered trademarks of Icom
Incorporated (Japan) in the United States, the United Kingdom, Ger-
many, France, Spain, Russia and/or other countries.
Microsoft and Windows are registered trademarks of Microsoft Cor-
poration in the United States and/or other countries.
All other products or brands are registered trademarks or trademarks
of their respective holders.
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R WARNING RF EXPOSURE! This device emits
Radio Frequency (RF) energy. Extreme caution should be ob-
served when operating this device. If you have any questions re-
garding RF exposure and safety standards please refer to the
Federal Communications Commission Office of Engineering and
Technology’s report on Evaluating Compliance with FCC Guide-
lines for Human Radio frequency Electromagnetic Fields (OET
Bulletin 65).

R WARNING! NEVER connect the transceiver to an
AC outlet. This may pose a fire hazard or result in an electric
shock.

R WARNING! NEVER operate the transceiver while
driving a vehicle. Safe driving requires your full attention—any-
thing less may result in an accident.

R WARNING! NEVER transmit without an operational
antenna for 1.2 GHz operation. Transmission into a shorted or
non resonant antenna may damage the transceiver.

R WARNING for data mode operation! The
saved file(s) in the shared folder may be modified or deleted,
or unknown file(s) may be copied into the shared folder from
the connected station when the transmission inhibit is re-
leased.

Icom Inc. assume no responsibility whatsoever for any dam-
ages or lost profits resulting from opportunities for signal com-
munications being lost because of the failure, malfunction,
poor condition, damage, or data loss of this unit or because of
such external causes as power failure. Icom also dismisses
all responsibility for demands made by a third party.

NEVER cut the DC power cable between the DC plug and
fuse holder. If an incorrect connection is made after cutting, the
transceiver may be damaged.

NEVER connect the transceiver to a power source of more
than 16 V DC. This will damage the transceiver.

NEVER connect the transceiver to a power source using re-
verse polarity. This will damage the transceiver.

NEVER expose the transceiver to rain, snow or any liquids.
The transceiver may be damaged.

NEVER operate or touch the transceiver with wet hands. This
may result in an electric shock or damage to the transceiver.

NEVER place the transceiver where normal operation of the
vehicle may be hindered or where it could cause bodily injury.

NEVER let objects impede the operation of the cooling fan on
the rear panel.

ii
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PRECAUTION
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PRECAUTION

DO NOT push the PTT when not actually desiring to transmit.

DO NOT allow children to play with any radio equipment con-
taining a transmitter.

During mobile operation, DO NOT operate the transceiver
without running the vehicle’s engine. When the transceiver’s
power is ON and your vehicle’s engine is OFF, the vehicle’s bat-
tery will soon become exhausted.

BE CAREFUL! The transceiver will become hot when op-
erating it continuously for long periods.

AVOID using or placing the transceiver in direct sunlight or in
areas with temperatures below –10°C (+14˚F) or above +60°C
(+140˚F).

AVOID the use of chemical agents such as benzine or alcohol
when cleaning, as they can damage the transceiver’s surfaces.

USE Icom microphones only (supplied or optional). Other man-
ufacturer’s microphones have different pin assignments and may
damage the transceiver if attached.

DO NOT use the supplied CD for any other devices.
The CD is for the ID-1 only.

If a connection cable is disconnected or has a loose connec-
tion during operation, an error may occur. Connect the con-
nectors correctly, and DO NOT touch the connectors during
operation.

For the operation of PC and peripheral devices, follow the in-
structions provided in the manuals which come with the PC
and peripheral devices.

This device may cause signal interference when used in a do-
mestic setting. When interference occurs, move this unit as
far as possible away from the affected device.

All copyrights associated with this manual and all intellectual
property rights associated with the hardware and software of
the ID-1 are held by Icom Inc.

Unauthorized reproduction or transmission of this manual, or
any part hereof, is prohibited.

The content of this manual, the hardware and software asso-
ciated with the ID-1, and the appearance of the ID-1 are all
subject to change without notice.

For U.S.A. only
CAUTION: Changes or modifications to this device, not ex-
pressly approved by Icom Inc., could void your authority to
operate this device under FCC regulations.
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SUPPLIED ACCESSORIES
qMicrophone (HM-118N) ……………………………………1
wExternal speaker (SP-22) …………………………………1
eEthernet cable coupler ……………………………………1
rDC power cable (3 m; 9.8 ft) ………………………………1
tUSB extension cable (1.5 m; 4.9 ft) ………………………1
yEthernet cable (3 m; 9.8 ft) …………………………………1
uSelf-adhesive rubber feet …………………………………1
iApplication CD ………………………………………………1
oRemote controller (RC-24)*…………………………………1
!0Mounting bracket for remote controller* …………………1
!1Mounting screws, nuts and washers* ………………1 set
!2Mic extension cable (2.5 m; 8.2 ft)* ………………………1

*Optional for some versions.

o !0

q

!2

ew

t y

u i

!1

r
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� Front panel

qMICROPHONE CONNECTOR [MIC]
Connects the supplied microphone or the remote con-
troller, RC-24 (optional for some versions). 

q +8 V DC output (Max. 100 mA)
w Channel up/down
e Data out
r PTT
t GND (microphone ground)
y MIC (microphone input)
u GND
i Data IN

wDATA TRANSMIT/RECEIVE INDICATOR
Lights green while receiving; lights red while transmitting
data in data mode.

ePOWER INDICATOR 
Lights while the transceiver power is turned ON.

rTRANSMIT/RECEIVE INDICATOR
Lights green while receiving; lights red while transmitting
in FM/digital voice mode.

tPOWER SWITCH [POWER]
Turns power ON and OFF when pushed for 1 sec.

q i

Front panel view

MIC

TD/RD PWR TX/RX POWER

TRANSCEIVER

ID-1

DIGITAL

q ew r t
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1� Rear panel

qETHERNET RECEPTACLE (p. 17)
Connects to a PC directly, or via an extension cable.

wEXTERNAL SPEAKER JACK [SP] (p. 16)
Connects the supplied (or optional) external speaker for
voice reception.

eCOOLING FAN
The fan rotates when the internal temperature of the trans-
ceiver exceeds the preset value until the temperature drops.
Also runs while receiving depending on the setting in set
mode. 

rANTENNA CONNECTOR (p. 13)
Connects a 50 Ω antenna with a type-N connector and a
50 Ω coaxial cable.

tUSB RECEPTACLE (p. 17)
Connects to a PC directly or via an extension cable.

yPOWER RECEPTACLE (p. 15)
Accepts 13.8 V DC ±15% with the supplied DC power
cable.

q ew r

t y
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� Microphones (HM-118N)

qPTT SWITCH
Push and hold to transmit; release to receive.

wUP/DOWN SWITCHES [UP]/[DN]
Push either switch to change operating frequency, mem-
ory channel, etc. 

eUP/DN LOCK SWITCH
Slide to toggle [UP]/[DN] switches function ON and OFF.

w

q

ON

OFF

e

• HM-118N
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1� Application screens (on PC screen)

DD Main screen
*The application screen can be seen after the application
installation. See page 30 for details.

qFILE MENU
Click to display the file menu to perform the following op-
eration.
• Transceiver initialization
• Opening a file
• Saving (over-write or with different file name) the set con-

tents
• Reads the transceivers memory data (See NOTE on p. 6)
• Printing out the memory contents
• Quitting the application

wVIEW MENU
Click to display the view menu to display the following
screens or selections.
• Memory channel list screen
• Set mode screen
• Font size setting
• Tool bar indication ON/OFF
• My call sign screen

q w e r t

!0!1!2!4!5!6!7!8@0@1 !9@2 !3

y u i o
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eOPTION MENU
Click the option menu to display and set the following
items.
• COM port setting screen
• “Wake up power ON” function

rHELP MENU
Click the help menu to display the following screen.
• Help file
• Application version information

tTOOL BAR
The following functions can be performed by clicking one
of the desired short cut button.
• Transceiver initialization
• Opening a file
• Saving the file
• Reads the transceivers memory data (See NOTE on p. 6)
• Displays memory channel list screen
• Displays set mode screen

yAUDIO VOLUME CONTROL [VOL]
Left clicking to decrease; right clicking to increase the
audio volume level.

uTRANSMIT INHIBIT BUTTON [TX inh]
Inhibits transmission during digital mode operation.

iAUDIO MUTE BUTTON [MUTE]
Mutes the audio output.

oFUNCTION BUTTONS 
[CD] : Click to display and hide the Received call

record screen.
[CS] : Click to display and hide the Select Call Sign

screen.
[LOW] : Click to select the transmit output power from

high and low.
[RP] : Click to select repeater shifting mode from RP–,

RP+, RPS and simplex (no indication).
[TONE] : During FM mode operation

Click to select tone condition from repeater
tone ON, tone squelch ON, pocket beep func-
tion ON and no tone operation.

[DSQL] : During Digital voice mode operation
Click to select squelch condition from digital
code squelch ON, digital call sign squelch ON,
pocket beep function ON and no digital squelch
operation.

[MW] : Click to display and hide the Memory program-
ming screen.

[PRIO] : Click to start and cancel priority watch function.
[SCAN] : Click to display the scan type selection screen.

After the scan type selection, starts the scan.
[MN] : Click to switch the memory name indication ON

and OFF during memory mode operation.
[BK] : Click to start break-in communication.
[AFC] : Click to turn the automatic frequency control

function ON and OFF.
[F.INP] : Click to display and hide the Keypad screen.
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1!0EMR MODE BUTTON [EMR]
Click to enter and exit EMR mode.

!1MESSAGE BUTTON [MSG]
Click to turn the message screen indication ON and OFF.

!2SQUELCH CONTROL [SQL]
Left click to decrease; right click to increase the squelch
level. 

!3SKIP BUTTON [SKIP]
During memory mode, click to turn the skip setting for the
selected memory channel ON and OFF.

!4MONITOR BUTTON [MONI]
Click to turn the monitor function ON and OFF.
While the function ON, any squelches, such as tone
squelch, are released and emits audio.

!5SET MODE BUTTON [SET]
Click to display and hide the Set mode screen.

!6OPERATING MODE BUTTON [MODE]
Click to select the operating mode from FM, digital voice
(DV) and data (DD).

!7CALL CHANNEL BUTTON [CALL]
Click to select a call channel (1–3).

!8VFO/MEMORY MODE BUTTON [V/M]
Click to switch between VFO and memory mode.

!9TUNING DIAL [DIAL]
Left click to decrease; right click to increase the operating
frequency or memory channel.

@0TUNING STEP BUTTON [TS]
Click to display the tuning step list.
After the tuning step selection, the list disappears.

@11 MHz TUNING BUTTON [MHz]
Click to turn the 1 MHz tuning ON and OFF.
While the 1 MHz tuning is selected, “Z” icon appears.

@2POWER BUTTON [POWER]
Click to turn the transceiver power ON and OFF.
Even the transceiver power is turned OFF, the control ap-
plication is still running.

NOTE: While reading the transceiver’s memory data
While reading the transceiver’s memory data the “ ” button
in the tool bar will change from Black to Red arrows. 
It is not recommended to save data or initialize the trans-
ceiver while the program is downloading the memory chan-
nel data. If transceiver initialization or save data buttons are
accidentally pushed, the dialog box shown below will appear.

It is recommended to click the cancel button to allow the task
of reading the transceiver to be completed. Then try the ini-
tialization or saving data. Completion of the download is indi-
cated when the arrows change from Red to Black.
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DD Memory channel list screen

qCHANNEL SELECT 
Select the memory channel for operation by double click-
ing and select “Move to this channel”.
“+” appears when the channel is selected.

wPROGRAMMED FREQUENCY
Enter the desired operating frequency.
Select the desired frequency cell, then enter the desired
frequency from the PC’s keyboard directly.

eOPERATING MODE
To select the desired operating mode, double click the
mode cell. Then click to select the desired operating mode,
FM, DV (Digital Voice) or DD (Data mode).

rREPEATER
Select the desired shift direction for repeater operation
from RP–, RP+, RPS and Simplex in RP cell, and enter the
desired offset frequency via the PC’s keyboard within 0 to
60 MHz range in Offset Freq. cell.
RP– : Negative shift
RP+ : Positive shift
RPS : For repeater operation in DD mode

tTONE/TSQL
Select the desired tone function from TONE, TSQL and
OFF in Tone Select cell, and select the desired tone fre-
quency for each Repeater Tone and TSQL Tone from the
list appeared by double clicking the cell.
TONE : Repeater tone ON
TSQL : Tone squelch ON

q w e r yt u i o
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1yDIGITAL
Select the desired digital squelch function from digital code
squelch, digital call sign squelch and OFF in DSQL cell,
and enter the desired digital code number within 00 to 99
range for the digital code squelch function.
DSQL : Digital call sign squelch ON
CSQL : Digital code squelch ON

uCALL SIGN
Enter the station’s call sign that you want to call into YOUR
cell, and repeater call sign into RPT1 and RPT2 cell.

iSKIP SETTING
Turn the skip function ON (SKIP) and OFF.
When ON is set, the memory channel will be skipped dur-
ing memory scan.

oMEMORY NAME
Enter the desired memory name.
Each name can have up to 10 characters.
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� Remote controller (RC-24; Optional for some versions)

1294.500 00
DV RP-

q w

e r t y u i o

Function display (p. 12) Keypad (pgs. 10, 11)

qTUNING DIAL [DIAL] 
Selects the operating frequency (p. 35), memory channel
(p. 72), the setting of the set mode value or condition and
the scanning direction.

wUP/DOWN SWITCHES [ ]/[ ]
➥ Adjusts the audio output level. (p. 34)
➥ After pushing [SQL], adjusts squelch level. (p. 33)

eMICROPHONE CONNECTOR [MIC]
Connects the microphone, supplied with the transceiver.

rVFO/MEMORY SWITCH [V/M] (p. 34)
Push to toggle VFO and memory mode.

tCALL SWITCH [CALL] (p. 73)
Push to select and toggle call channel 1, 2 and 3.

yOPERATING MODE SWITCH [MODE] (p. 38)
Push to select an operating mode from FM, DV (Digital
Voice) and DD (Data mode).

uTRANSMIT INHIBIT•SET MODE SWITCH [TXinh• ]
➥ Push to inhibits a transmission during DD mode. (p. 67)
➥ Push to enter the message indication mode during DV

mode. (p. 50)
➥ Push for 0.5 sec. to enter set mode. (p. 100)

iSQUELCH SWITCH [SQL] (p. 33)
Push this switch then push either [ ] or [ ] switch to ad-
just the squelch level.

oPOWER SWITCH [PWR] (p. 33)
Turns power ON and OFF when pushed for 0.5 sec.
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1DDKeypad
[CS• •1]
➥ Push to enter call sign select mode. (p. 40)
➥ Push for 0.5 sec. to enter received call record

indication. (p. 47)
➥ After pushing [F.INP•L], input digit “1” for op-

erating frequency or memory channel. 

[MHz• •2]
➥ Push to select 1 MHz tuning. (p. 35)
➥ Push for 0.5 sec. to enter tuning step select-

ing condition. (p. 37)
➥ After pushing [F.INP•L], input digit “2” for op-

erating frequency or memory channel. 

[LOW•3]
➥ Push to toggle low and high transmit output

power. (p. 45)
➥ After pushing [F.INP•L], input digit “3” for op-

erating frequency or memory channel. 

[RP•4]
➥ Push to toggle repeater operating mode.

(pgs. 58, 61, 67)
➥ After pushing [F.INP•L], input digit “4” for op-

erating frequency or memory channel. 

[TONE• •5]
➥ FM mode: Push to turn the repeater tone,

tone squelch and pocket beep function ON
and OFF.

➥ DV Mode: Push to turn the digital call sign,
digital code squelch and pocket beep function
ON and OFF.

➥ After pushing [F.INP•L], input digit “5” for op-
erating frequency or memory channel. 

[MW•6]
➥ Push to enter select memory write condition.

(p. 76)
➥ After pushing [F.INP•L], input digit “6” for op-

erating frequency or memory channel. 

[PRIO• •7]
➥ Push to start and stop priority watch. (p. 91)
➥ Push for 0.5 sec. to set the selected memory

channel as a skip channel during memory
mode. (p. 88)

➥ After pushing [F.INP•L], input digit “7” for op-
erating frequency or memory channel. 

[SCAN•8]
➥ Push to start and stop scanning. (p. 84)
➥ After pushing [F.INP•L], input digit “8” for op-

erating frequency or memory channel. 
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[MN•9]
➥ Push to select memory name or frequency in-

dication during memory mode. (p. 82)
➥ After pushing [F.INP•L], input digit “9” for op-

erating frequency or memory channel. 

[BK• •.]
➥ Push to enable a break call during digital

voice operation. (p. 110)
➥ Push for 0.5 sec. to select “CQ” as a call sign

during digital voice operation. (p. 46)
➥ After pushing [F.INP•L], selects previous

“MHz” digits frequency for operating fre-
quency. (p. 36)

[AFC• •0]
➥ Push to turn the AFC (Automatic Frequency

Control) function ON and OFF. (p. 111)
➥ Push for 1.5 sec. to turn the EMR mode ON,

and push for 0.5 sec. to turn the function OFF
during digital voice mode operation. (p. 108)

➥ After pushing [F.INP•L], input digit “0” for op-
erating frequency or memory channel. 

[F.INP•L]
➥ Push to enable the direct frequency or mem-

ory channel number input. 
➥ Push for 0.5 sec. to turn the RC-24 key lock

function ON and OFF. (p. 38)

ID-1_ENG_2.qxd  04.9.22 9:29  Page 11 (1,1)



12

1PANEL DESCRIPTION

New2001

1DDFunction display

qS/RF INDICATORS
➥ Shows the relative signal strength while receiving sig-

nals in 3 steps. 
➥ Shows the output power level while transmitting. 

wTRANSMIT INDICATOR 
Appears while transmitting. 

eBUSY INDICATOR 
Appears when a signal is being received, the squelch is
open, or the monitor function is activated. 

NOTE:  If this indicator appears and no audio is heard it
is one of several conditions.  
1. Verify audio level setting.
2. Verify connection of external speaker.
3. FM: Signal coming in, but does not match TSQL.

Digital Voice: Incoming signal does not match call
signs in the call sign squelch list.

rPOCKET BEEP INDICATORS (p. 94)
Appears when the pocket beep function is activated.

tLOCK INDICATOR (p. 38)
Appears when the lock function is in use. 

yLOW POWER INDICATOR 
Appears when low output power is selected. 

uMESSAGE INDICATOR 
Blinks when a message is received. (p. 51)

iMULTI-FUNCTION INDICATOR 
Shows variety of information, such as the operating fre-
quency, operating mode, memory names, set mode item
and conditions.

1294.500
FM RP-

M00

q

i

w e r t y u
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2
� Unpacking
After unpacking, immediately report any damage to the deliv-
ering carrier or dealer. Keep the shipping cartons.

For a description and a diagram of accessory equipment in-
cluded with the ID-1, see ‘Supplied Accessories’ on p. iv of
this manual.

� Selecting a location
Select a location for the transceiver that allows adequate air
circulation, free from extreme heat, cold, or vibrations, and
away from TV sets, TV antenna elements, radios and other
electromagnetic sources.

� Antenna connection
For radio communications, the antenna is of critical impor-
tance, along with output power and sensitivity. Select an-
tenna(s), such as a well-matched 50 Ω antenna, and feedline.
1.5:1 or better of Voltage Standing Wave Ratio (VSWR) is
recommended for your desired band. Of course, the trans-
mission line should be a coaxial cable.

CAUTION: Protect your transceiver from lightning by using
a lightning arrestor.

NOTE: There are many publications covering proper an-
tennas and their installation. Check with your local dealer
for more information and recommendations.

• Antenna location for mobile operation
To obtain maximum performance from the transceiver, select
a high-quality antenna and mount it in a good location. A non-
radial antenna should be used when using a magnetic mount.

ID-1

To antenna

Roof-mount antenna
(Drill a hole or use a magnetic mount.)

Gutter-mount antenna

Trunk-mount
antenna
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2INSTALLATION AND CONNECTIONS

2
Type-N CONNECTOR INSTALLATION EXAMPLE

15 mm ≈ 19⁄32 in   6 mm ≈ 1⁄4 in   3 mm ≈ 1⁄8 in

Slide the nut, washer, 
rubber gasket and clamp 
over the coaxial cable, 
then cut the end of the 
cable evenly.

Strip the cable and fold the 
braid back over the clamp.

Soft solder the center 
conductor. Install the 
center conductor pin and 
solder it.

Carefully slide the plug 
body into place aligning the 
center conductor pin on the 
cable. Tighten the nut onto 
the plug body.

q

w

e

r

15 mm

3 mm
6 mm

No space

Solder hole

Be sure the center conductor is 
the same height as the plug body.

Clamp
Center
conductor

Washer

Nut Rubber gasket
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2 INSTALLATION AND CONNECTIONS

New2001

� Power supply connections

Use a DC power supply with a 10 A capacity and above when
operating the transceiver with AC power. Refer to the dia-
grams below.

• Connecting to a DC power supply

• Connecting to a vehicle battery

12 V

Grommet

NOTE: 
Use terminals for the 
cable connections.

WARNING!
NEVER
remove the
fuse holders.

Crimp Solder

12 V
battery

Supplied
DC power cable

+ red

ID-1

_ black

red⊕ black−

DC power
supply 13.8 V

AC
outlet

Fuses
15 A

Black
Red⊕

−

⊕ −

ID-1

CAUTION: Before connecting the DC power cable,
check the following important items. Make sure:
• The [POWER] switch is OFF.
• Output voltage of the power source is 12–15 V when you

use a power supply.
• DC power cable polarity is correct.

Red : positive + terminal
Black : negative _ terminal
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2INSTALLATION AND CONNECTIONS

New2001

2
� Microphone and speaker connections
Connect the supplied microphone to the [MIC] connector on
the remote controller (RC-24) or front panel and the speaker
to the [SP] connector on the rear panel as follows.

• Microphone connection through RC-24 • Microphone connection without RC-24

• Speaker connection

ID-1

SP-22

to [SP]

ID-1
to [MIC]

ID-1

Mic extension 
cable, OPC-647
(2.5 m; 8.2 ft)

RC-24

to [MIC]

to [MIC]
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2 INSTALLATION AND CONNECTIONS

New2001

� Connecting a PC 
DD PC connection for control
USB (Universal Serial Bus) cable is used for the connection
between the ID-1 and a PC.
An USB extension cable, OPC-1127 (1.5 m; 4.9 ft), is sup-
plied with the transceiver for extended connection.

NOTE: When connecting the ID-1 and the PC through an
USB hub, use the self-powered type.

DD PC connection for data operation
Ethernet cable connection is additionally required for the data
operation.
Connect the Ethernet receptacle to the Ethernet port on your
PC directly or through the supplied extension cable with the
cable coupler, if desired.

NOTE: When no Ethernet port is available with your PC,
install an Ethernet card and it’s driver before connecting
the ID-1. Ask your local computer dealer for details about
installing a Ethernet card to your computer.

ID-1

PC

Use the supplied OPC-1069, Ethernet cable (3 m; 9.8 ft), 
and the cable coupler for extension, if desired.

to Ethernet
port

to card
slot

Cable coupler

Ethernet card

ID-1

PC

Use the supplied 
USB extension cable,
OPC-1127 (1.5 m; 4.9 ft),
if desired.

to USB
port
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3DRIVER INSTALLATION

2
3

The displayed dialog boxes or indications may differ
slightly from the following instructions according to your
system conditions, or environment.

� Microsoft® Windows® XP
qConnect the ID-1 to the desired USB port.

• Push [POWER] to turn the power ON.
• “Found New Hardware” appears as below.

wThe “Found New Hardware Wizard” will come up as below.
Insert the supplied CD into the CD drive, select “Install the
software automatically (Recommended),” then click
[Next>].

Click

Select
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3 DRIVER INSTALLATION

New2001

eThe wizard starts searching for the driver and shows the
dialog below during search.

rAfter the driver is found, the “Hardware Installation” dialog
box appears as below. 
Click [Continue Anyway] to start the installation.

tWindows starts installing the USB driver.

yAfter the installation is completed, click [Finish].

Click
Click
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3DRIVER INSTALLATION

New2001

3

uThe “Found New Hardware Wizard” will come up again to
install the USB serial port driver.
Select “Install the software automatically (Recommended),”
then click [Next>].

iAfter the driver is found, the “Hardware Installation” dialog
box appears as below. 
Click [Continue Anyway] to start the installation.

oWindows starts installing the USB driver.

Click

Click

Select
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3 DRIVER INSTALLATION

New2001

!0After the installation is completed, click [Finish].

!1After clicking [Finish], the dialog appears as below.

!2Eject the CD.
• Rebooting the PC is recommended.

Click
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3DRIVER INSTALLATION

New2001

3

� Microsoft® Windows® 98/Me
qConnect the ID-1 to the desired USB port.

• Push [POWER] to turn the power ON.
• “New Hardware is found” dialog box appears.

wThe “New Hardware Found” will come up as below. Click
[Browse...].

e Insert the supplied CD into the drive.
rClick [Z] to select the appropriate CD-ROM drive then click

“Driver” folder. After the driver is found, click [OK].

tClick [OK].
• The driver installation starts.

yAfter the installation, eject the CD.
• Rebooting the PC is recommended.

Click

e Click

q Click to select

w Select

Click
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3 DRIVER INSTALLATION

New2001

� Microsoft® Windows® 2000
qConnect the ID-1 to the desired USB port.

• Push [POWER] to turn the power ON.
• “Found New Hardware” dialog box appears below.

wThe “Found New Hardware Wizard” will come up as below.
Click [Next>].

eSelect “Search for a suitable driver for my device (recom-
mended),” then click [Next>].

Click

Select

Click
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3DRIVER INSTALLATION

New2001

3
rSelect “CD-ROM drives,” and insert the supplied CD into

the CD drive, then click [Next>].
tWhen the driver is found, the following dialog is displayed.

Click [Next>] to start the installation.

NOTE: When the appropriate driver is not found, a differ-
ent dialog is displayed. In such case, click [<Back], select
“Specify a location,” click [Next>], then type “D:\driver” in
the text box to select the “Driver” folder in the CD (if CD
drive is D).

ClickClick

Select
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3 DRIVER INSTALLATION

New2001

yAfter the installation is completed, click [Finish].

uThe “Found New Hardware” wizard appears again.

iClick [Next>].

ClickClick
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3DRIVER INSTALLATION

New2001

3
oSelect “Search for a suitable driver for my device (recom-

mended),” then click [Next>].
!0Select “CD-ROM drives,” then click [Next>].

Click

Select

Click

Select
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3 DRIVER INSTALLATION

New2001

!1When the driver is found, the following dialog is displayed.
Click [Next>] to start the installation.

NOTE: When the appropriate driver is not found, a differ-
ent dialog is displayed. In such case, click [<Back], select
“Specify a location,” click [Next>], then type “D:\driver” in
the text box to select the “Driver” folder in the CD (if CD
drive is D).

!2After the installation is completed, click [Finish].

!3Eject the CD.
• Rebooting the PC is recommended.

Click
Click
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3DRIVER INSTALLATION

New2001

3

� COM port confirmation
After the driver installation, confirm the driver availability and
the port number are recommended.

In this section, screen shots of Windows XP are used for in-
struction example. However, the instructions are similar to an-
other operating systems, Windows 98, Me and 2000.

qBoot up the Windows.
wSelect the “Control Panel” in the Start menu.

• Control panel appears as shown in the next step below.
eClick the “Performance and Maintenance.” 

• Performance and Maintenance menu appears.

rClick the “System,” then click the “Hardware” tab in the dis-
played System Properties screen.

tClick the [Device Manager]. 

• Device Manager screen appears as below.

Click

Click
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3 DRIVER INSTALLATION

New2001

yClick “ ” of the “Ports (COM & LPT)” to display the usable
COM port and the port number.

uConfirm the USB serial port availability and the COM port
number.
• The COM port number is used for the COM port setup. (p. 32)

iClose the Device Manager, System Properties screen and
then Control panel. 

Confirm the USB serial port availability and the COM port
number.
(In this example, the USB serial port number is “4.”)

Click
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4APPLICATION INSTALLATION

3
4

q Insert the CD into the CD drive.
wOpen the CD drive contents via “My computer” or “Win-

dows Explorer.”
• “Driver” and “ID1” folders are available.

eDouble click “Setup.exe” file in “ID1” folder.

• The “InstallShield® Wizard” starts preparing the installation.

rAfter the preparation, the following dialog is displayed.
Click [Next>].

Click

Double click
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4 APPLICATION INSTALLATION

New2001

tConfirm the location, then click [Next>] to start the installa-
tion.

• Click [Browse...] then type the desired location if you specifying
the installation location.

yAfter the installation is completed, click [Finish].

uEject the CD.
• The ID-1 shortcut icon is created on the desktop.
• Rebooting the PC is recommended.

Click
Click
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5BASIC OPERATION

4
5

� Preparation
DD Turing power ON/OFF from the applica-

tion
qBoot up Windows.
wStart the ID-1 application by double clicking the icon on the

desktop, or select “ID-1” in the program menu.
• ID-1 main screen appears and “COM Port Error” may be dis-

played for 1st time as below.
eClick [Port Setup].

• COM Port Setup dialog box appears.

rEnter the appropriate COM port number from the PC’s key-
board within 1–256 range, then click [Apply].
• See pages 28, 29 for how to confirm the COM port number.
• The transceiver power comes up and the default frequency will

be displayed on the main screen when the correct port number is
entered.

• Once the COM port is set, this operation will not be necessary.
• When using multiple radios with the same Laptop, changing the

COM Port number will be required each time a new radio is con-
nected to the computer.

tClick [POWER] to turn the power OFF.
• The transceiver power can also be turned OFF by pushing

[POWER] on the ID-1 front panel.

Click

Enter the appropriate
port number

(within 1–256)

Click

Click
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5 BASIC OPERATION

New2001

yTo quit the application, select “Exit(X)” in the file menu, or
click “ ” button on the top right corner of the screen.
• The application cannot be quit by turning OFF the transceiver’s

power only. And also, the transceiver power is still ON even the
application is quit without turning OFF with [POWER].

Hint!
The ID-1 has “WakeUp PowerON” function, which automati-
cally powers ON when the application is started up.
To turn the function ON and OFF, select “Wakeup PowerON”
item in option menu. “✔” appears when the function is acti-
vated.

DD Turing power ON/OFF from the RC-24
➥ Push [PWR] to turn the power ON.

• Pushing [POWER] on the ID-1 front panel also turns power ON.
• Push [PWR] (or [POWER] on the ID-1 front panel) for 0.5 sec. to

turn the power OFF.

� Squelch level adjustment
(FM mode only)

DD From the application 
➥ Set the pointer on [SQL] control then; right click to in-

crease, left click to decrease the squelch level.
• Set [SQL] within 9–12 o’clock position is recommended.

DD From the RC-24 
➥ Push [SQL], then push [ ] to increase, [ ] to decrease

the squelch level.
• “SQL” and set level appear on the function display.
• Set the squelch level within 9 to 19 is recommended.

[SQL]

[     ]
[     ]

Right click to increase; Left click to decrease

[PWR]
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5BASIC OPERATION

5

� Audio level adjustment
DD From the application 
qOpen the squelch.

• The monitor function is available to open the squelch without ad-
justing [SQL] level— click [MONI] to open and close the squelch.

wSet the pointer on [VOL] control then; right click to in-
crease, left click to decrease the audio level.

DD From the RC-24
➥ Push [ ] to increase, [ ] to decrease the audio level.

• “VOL” and set level appear on the function display.
• The audio level can be adjusted within 0 (no audio) to 32 (max.

audio) levels.

� VFO and memory mode
DD From the application 
➥ Click [V/M] to toggle between VFO and memory mode.

DD From the RC-24
➥ Push [V/M] to toggle between VFO and memory mode.

• “M” appears besides memory channel number when memory
mode is selected.

[V/M]

Click “VFO” or “MEMO” appears

[     ]
[     ]

Right click to increase; Left click to decrease
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5 BASIC OPERATION
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� Setting a frequency
DD Using the application tuning dial 
qSet the pointer on the tuning dial control then; right click to

increase, left click to decrease the operating frequency.
• While clicking and holding either right or left button of the mouse,

the operating frequency increases or decreases continuously.
• Operating frequency changes in the selected tuning steps. See

page 37 for the tuning step selection.

wTo change the frequency in 1 MHz steps, click [MHz], then
click (left or right) the tuning dial.
• “Z” appears above the 1 MHz digit when the 1 MHz tuning step

is selected.

Hint!
[⇐] and [⇒] keys on the PC’s keyboard also functions as the
tuning dial.
Press [⇐] to decrease; press [⇒] to increase the operating
frequency.

DD Using the RC-24 tuning dial 
qRotate [DIAL] to set the operating frequency.

• Operating frequency will be changed with the selected tuning
steps. See page 37 for the tuning step selection.

wTo change the frequency in 1 MHz steps, push [MHz•
•2], then rotate the [DIAL].
• Below 1 MHz digits disappear when the 1 MHz tuning step is se-

lected.

DD Using microphone [UP]/[DN]
➥ Push the microphone’s [UP]/[DN] to set the operating fre-

quency.
• While pushing and holding either [UP] or [DN], the operating fre-

quency increases or decreases continuously.
• Operating frequency will be changed with the selected tuning

steps. See page 37 for the tuning step selection.

[MHz•        •2]

[DIAL]

Right click to increase; Left click to decrease
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5

DD Direct frequency input from the application
qClick [F.INP].

• Keypad screen appears.

wClick 4 to 7 digit desired numeric buttons to enter the de-
sired operating frequency within 1240.000 to
1300.000 MHz range.
• After the 7th digit is entered, the frequency automatically fixed

and set to the transceiver.
• Click [ENT] to fix and set the frequency when 4 to 6 digits are en-

tered.
• When a digit is mistakenly input, click [CE] to clear the input, then

input from the 1st digit.
• Click [.] first, when changing frequency below 100 kHz digits.

Hint!
The direct frequency input can also be performed from the
PC’s keyboard. 
Enter the desired operating frequency via the PC’s keyboard.
e.g. When entering 1295.575 MHz;

[1], [2], [9], [5], [.], [5], [7], [5]

DD Direct frequency input from the RC-24
qPush [F.INP•L]

• Operating frequency disappears.

wPush the appropriate 7-digit keys to enter the desired op-
erating frequency.
• After the 7th digit is entered, the frequency automatically fixed

and set to the transceiver.
• When a digit is mistakenly input, push [F.INP•L] to clear the

input, then input from the 1st digit.
• Push [BK• •.] first, when changing frequency below 100 kHz

digits.

[F.INP•L]

Numeric buttons

Click
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� Tuning step selection
DD Selecting with the application 
➥ Click [TS], then select the desired tuning step from the list.

• 5, 6.25, 10, 12.5, 20, 25, 50 and 100 kHz tuning steps are avail-
able.

DD Selecting with the RC-24 
qPush [MHz• •2] for 0.5 sec.

• “TS” and the selected tuning step appear.

wRotate [DIAL] to select the desired tuning step.
• 5, 6.25, 10, 12.5, 20, 25, 50 and 100 kHz tuning steps are avail-

able.
• When no operation is performed for 5 sec., both “TS” and tun-

ing step selection indication disappear and the transceiver return
to normal condition.

[DIAL]

[MHz•        •2]

“✔” appears for the 
selected tuning step

Click
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New2001

5

� Lock function (RC-24 only)
To prevent accidental frequency changes and unnecessary
function access, use the lock function.

➥ Push [F.INP•L] for 0.5 sec. to turn the lock function ON
and OFF.
• “ ” appears when the lock function ON.
• [PTT] (microphone), [ ], [ ], [SQL] and [LOW•3] can be used

while the lock function is in use.

� Operating mode selection
The ID-1 has 3 operating modes— FM, Digital voice and Data
modes.

DD Selecting with the application 
➥ Click [MODE] to select the desired operating mode.

• DV for Digital voice, DD for Data mode.

DD Selecting with the RC-24
➥ Push [MODE] to select the desired operating mode.

• “FM,” “DV” or “DD” is displayed.

[MODE]

ClickMode indication

[F.INP•L]
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6
� Your call sign setting
Your call sign must be programmed for both Digital voice and
data modes communications. 
Up to 5 call signs for your group members can be pro-
grammed.

DD Setting with the application 
qClick [CS].

• Select Call Sign screen appears.

wClick either [Y]/[Z] button for “MY” to select the call sign
channel.

eSelect “MY” text box then type your call sign from the PC’s
keyboard.

rClick [OK] for “MY” to program.

Click

Type your call sign here.

Click either
button.

Click
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6CALL SIGN SETTING
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6

DD Setting with the RC-24
qPush [CS• •1] 4 times to enter call sign select mode and

select My call sign item.
• “MY” call sign channel number and programmed call sign appear.

wRotate [DIAL] to select the desired call sign channel.
• Displays “********” when no call sign is programmed.

ePush [V/M] to enter the call sign edit condition.
• The 1st digit blinks.

rPush [CALL] or [MODE] to select the digit to be edited.
• Pushing [CALL] moves the cursor to left; pushing [MODE] moves

cursor to right.

[CALL]

[MODE]

S ç å A AB
MY 1:********

[V/M]

E /
MY 1:********

[DIAL]

Channel number

E /
MY 0:********

[CS•        •1]
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tPush [SQL] several times to select the desired character
group, then rotate [DIAL] to select the desired character.
• AB : Alphabets (A to Z)
• 12 : Numbers (0 to 9)
• _/ : Symbols (space and /)

yPush [TXinh• ] to enter the selected character.
• The cursor move to right automatically.

uRepeat the steps r to y to enter your call sign.
iPush [V/M] to fix the call sign and exit the edit condition.
oPush [CALL] to display the note.

!0Push [V/M] to enter the note edit conditions.
• The 1st digit blinks.

!1Repeat the steps r to i to enter the note.
• Up to 4-digit note can be set.

!2Push [V/M] to fix the note and exit the edit condition.
!3Push [CS• •1] to exit call sign select mode.

S ç å A AB
/

[V/M]

S MY 1:AAAAAAAA
/

[CALL]

S ç å A AB
MY 1:A*******

[TXinh•        ]

S ç å A AB
MY 1:********

[SQL]

Shows the selected character.
Shows the selected character group.

[DIAL]
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� Station/Repeater call sign setting
Station call sign must be set for the specified station call as
well as repeater operation in both Digital voice and data
modes communications. 

DD Setting with the application 
qClick [CS] to shows the Select Call Sign screen.
wType the desired station/repeater call sign into the YOUR’s

text box directly. 
• Call sign is also being programmed in RPT1 and RPT2.

eClick [OK] to program.

rRepeat steps w and e to program another station call
sign.

DD Setting with the RC-24
qPush [CS• •1] once to enter call sign select mode and

select station call sign item.
• “UR” and the selected call sign appear in the upper line, station

call sign channel number and programmed call sign appear in
the lower line.

wRotate [DIAL] to select the desired station call sign record
channel to be programmed.

[DIAL]

E s00:
UR  :CQCQCQ

W

[CS•        •1]

Record
number

Selected call sign

Click to program.

Enter the desired call sign 
directly.
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ePush [V/M] to enter the call sign edit condition.
• The 1st digit blinks.

rPush [CALL] or [MODE] to select the digit to be edited.
• Pushing [CALL] moves the cursor to left; pushing [MODE] moves

cursor to right.

tPush [SQL] several times to select the desired character
group, then rotate [DIAL] to select the desired character.
• AB : Alphabets (A to Z)
• 12 : Numbers (0 to 9)
• _/ : Symbols (space and /)

yPush [TXinh• ] to enter the selected character.
• The cursor move to right automatically.

S ç å A AB
UR  :AQCQCQ

[TXinh•        ]

S ç å A AB
UR  :CQCQCQ

[SQL]

Shows the selected character.
Shows the selected character group.

[DIAL]

[CALL]

[MODE]

S ç å A AB
UR  :CQCQCQ

[V/M]
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uRepeat the steps r to y to enter the desired station or re-
peater call sign.

iPush [V/M] to program the call sign and exit the edit condi-
tion.

oRepeat steps w to i to program another station/repeater
call signs.

✔ For your information:
Station and/or repeater call sign can be programmed from
Received call record when a call is received.
See page 47 for details.

E s00:JA3YUA
UR  :JA3YUA

W

[V/M]
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7
� FM mode operation
qSet the desired frequency in VFO mode from the applica-

tion or the RC-24. (pgs. 35, 36)
• Set the squelch (p. 33) and volume (p. 34) level as desired.

wSelect FM mode with [MODE].
eClick [LOW] in the application (main screen); or push

[LOW•3] on the RC-24 to select the desired output power.
• “LOW” appears when low power is selected; disappears when

high power is selected.

rPush and hold [PTT] to transmit and speak into the micro-
phone at normal voice level.

tRelease [PTT] to return to receive.

� Digital voice mode operation
qSet the desired frequency in VFO mode from the applica-

tion or the RC-24. (pgs. 35, 36)
• Set the volume (p. 34) level as desired.

wSelect DV (Digital voice) mode with [MODE]. 
eClick [LOW] in the application (main screen); or push

[LOW•3] on the RC-24 to select the desired output power.
• “LOW” appears when low power is selected; disappears when

high power is selected.

DD When sending a CQ 
rSelect “CQ” as the call sign.

Application
- Click [CS] to shows the Select Call sign screen.
- Click “CQ” button of “YOUR” to display “CQCQCQ.” 
- Click [OK].

Click to displays “CQCQCQ.”

[LOW•3]

[MODE]

ClickClick
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RC-24
- Push [BK• •.] for 0.5 sec. 

• “ ” appears beside the operating mode indication, “DV.”

DD When calling the desired station
rSet the desired call sign.

Application
- Click [CS] to shows the Select Call sign screen.
- Click [Z] to select the desired call sign (previously called),

or enter the desired call sign into the text box directly.
- Click [OK].

RC-24
- Push [CS• •1].
- Rotate [DIAL] to select the desired call sign (pro-

grammed), or push [V/M] then set the desired call sign
(see pgs. 42–44), then push [SQL] for 0.5 sec.

- Push [CS• •1] 4 times to exit call sign select mode.

tPush and hold [PTT] to transmit and speak into the micro-
phone at normal voice level.
• Transmit indicator appears and the RF meter shows the output

power.
• The programmed your (“MY”) call sign is displayed on the RC-

24 function display.
yRelease [PTT] to return to receive.

• The other station call sign will be received.
• Up to 10 received call signs can be stored into the received call

record automatically. See page 47 for details.

NOTE: The digital modes operation is vastly different than
FM. One of the differences is in the digital modes the
squelch does not function, changing the squelch setting or
pressing the moni button will not open to hear the hiss of
“White Noise.”

E s00:JA3YUA
UR  :JA3YUA

W

Click to select the desired 
call sign (programmed)
; or enter the desired call 
sign directly.

LOW

DV
00 1294.500

[BK•        •.]
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� When receiving a Digital call
When an individual station call is received, the calling station
call sign can be stored into the received call record.
The record screen will automatically be displayed when an in-
dividual station call is received.

The record is cleared once turning power OFF.

DD Received call record— application
qWhen a call is received during Digital mode operation, both

Voice and Data, the Received call record screen appears
automatically by default.
• Various information, such as calling station, called station, re-

peater call signs, status, date and calling type, are listed.

wTo reply to a call, click to select the desired call record then
click [select] button in the screen.
• The “Caller –>” call sign is set for call.
• Also, the set call sign is programmed for station/repeater call

sign selection list automatically.
eTo close the screen, click [Close] button or “ ” in the

screen, or click [CD] in the main screen.

DD Received call record— RC-24
qTo confirm the received calls, push [CS• •1] for 0.5 sec.

to enter receive call sign indication mode.
• “Caller” call sign is displayed.

wPush [CS• •1] to change the record content.
• “Called,” “RxRPT1” and “RxRPT2” are available.

eRotate [DIAL] to see the other call records.
rTo reply a call, select the desired call record then push

[SQL] for 0.5 sec.
• The call sign is set for the reply call.
• Also, the set call sign is programmed for station/repeater call

sign selection list automatically.
tTo return to operating condition, push [CS• •1] for

0.5 sec. again.

Caller:
Receive Callsign

[CS•        •1]

Call sign is displayed here.
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DD Automatic received call record indication
The automatic Received call record screen indication can be
deactivated, if desired.

qClick [CD] to display the Received call record screen.
wClick “Displays when new call sign signal is received” to

turn the automatic indication ON and OFF.
• ON (“✔”) : The record screen automatically appears when

a call is received. (default)
• OFF (no “✔”) : The record screen appears only when [CD] is

clicked.

DD Saving the received call record 
The displaying contents of the Received call record screen
with the operating frequency and mode, can be saved into the
PC.

➥ Click [SaveAs] to save the contents into the PC.
• Specify the desired file name and select saving location.
• The file is saved in “csv” format.

NOTE: The saved data can not be re-loaded with the ID-1
control application. Load the file with a spreadsheet soft-
ware for log management, etc.

Click to save.

✔ About status indication
A status is indicated in digital repeater operation as follow;
RPT UP : When receiving the signal that another station

accessing to the repeater.
UR? : When the target station does not reply the call.
RPT? : When the linking repeater is unable to found.

Click to remove “✔.”
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� Short message function
ID-1 has a short message function in Digital Voice mode op-
eration. This function allows simultaneous 20-character
(max.) message transmission or reception with the voice
communication.

DD Short message operation— application
qDuring Digital Voice operation, click [MSG].

• Set the desired operating frequency and call sign, etc., in ad-
vance.

• “Message Reception and Transmission” screen appears.

wType the desired message into the “Setup of message,”
then click [OK].
• Up to 20-character message can be set.
• Up to 6 messages can be stored for transmission.
• When selecting a stored message, click [Y]/[Z].

eClick “Message is transmitted” check box to display “✔”
mark.

rPush [PTT] to make a call.
• The message is transmitted immediately with your voice.
• When transmitting continuously, the message is transmitted in

each 30 sec.
tWhen a message is received, the contents and the call

sign are displayed in the RX area.
• Up to 20 messages can be stored for reception.
• The same message sending from the same call sign station

won’t be displayed repeatedly.
yTo close the screen, click “ ” in the screen, or click [MSG]

in the main screen.

NOTE: 
The “Message Reception and Transmission” screen dis-
played automatically when a new message is received in
default setting. This can be turned OFF if desired.
• ON (“✔”) : The screen automatically appears when a new

message is received. (default)
• OFF (no “✔”) : The screen appears only when [MSG] is clicked.

Type the message.

Click to select the message.

See the note below.

Received message and call 
sign are displayed here.

Click to display “✔” to 
transmit the message.

Click
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DD Short message operation— RC-24
qDuring Digital Voice operation, push [TXinh• ].

• Set the desired operating frequency and call sign, etc., in ad-
vance.

• “TX Message” appears.

wRotate [DIAL] to select the desired message channel.
• Ch1 to Ch6 are available.

ePush [V/M] to enter the message edit condition.
rPush [CALL] or [MODE] to select the digit to be edited.

• Pushing [CALL] moves the cursor to left; pushing [MODE] moves
cursor to right.

tPush [SQL] several times to select the desired character
group, then rotate [DIAL] to select the desired character.
• AB : Alphabets (A to Z)
• ab : Alphabets (a to z)
• 12 : Numbers (0 to 9)
• _/ : Symbols (space and /)
• !" : Symbols (! ” # $ % & ’ ( ) ✱ + , – . : ; < = > ? @ [ \ ] ^ _ ` {

| } ~)

yPush [TXinh• ] to enter the selected character.
• The cursor move to right automatically.

uRepeat the steps r to y to enter the desired station or re-
peater call sign.

iPush [V/M] to program the call sign and exit the edit condi-
tion.

�Continue to the next page

TX1: ç å A AB

[SQL]

Shows the selected character
Shows the selected character group

[DIAL]

[CALL]

[MODE]

[TXinh•        ]

TX Message TR
Ch1 OFF:
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D Short message operation— RC-24 (continued)
oPush [CALL] to turn the message transmission ON.

!0Push [PTT] to make a call.
• The message is transmitted immediately with your voice.
• When transmitting continuously, the message is transmitted in

each 30 sec.
!1When a message is received, the message indicator, “✱,”

blinks.
• Only 1 message can be stored for reception in the RC-24.
• The same message sending from the same call sign station

won’t be displayed repeatedly.
• The message in the RC-24 will be cleared when ID-1 is powered

OFF.

!2Push [TXinh• ] then push [SQL] to select “RX Mes-
sage” indication.
• The message indicator “✱,” disappears.

!3Push [CALL] or [MODE] to scroll the message manually.
• Pushing [CALL], scrolls the message to left; pushing [MODE]

scrolls the message to right.
!4Push [V/M] to display the call sign.

• Push [CALL] or [MODE] to scroll the note, if necessary.

!5Push [TXinh• ] to return to exit from the message indi-
cation condition.

Call sign is displayed here.

Message is displayed here.

Push [V/M] to toggle between message 
and call sign indications.

RX:
åç

åç
TRRX Message

DV
1294.500 00

RP-

Message indicator blinks.

[CALL]

TX Message TR
Ch1 ON :How are
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DD Automatic message indication 
The received message can be displayed on the RC-24 with-
out selecting the “RX Message” indication.

• Setting from the application
qDisplays set mode screen by performing one of the follow-

ing operations.
- Select “Edit SetMode(C)...” in view menu.
- Click “ ” button in tool bar.
- Click [SET].
- Press [F7] key on the PC keyboard.

wDouble click “Auto Message Disp” cell, then select the
function ON and OFF.
• To close the screen, click “ ” or repeat the operation as step q.

• Setting from the RC-24
qPush [MODE] several times to select DV or DD mode.
wPush [TXinh• ] for 0.5 sec. to enter set mode.
ePush [MODE] or [TXinh• ] to select “Auto RxMSG

Disp” item.
rRotate [DIAL] to turn the function ON and OFF.
tPush [PWR] momentarily to exit set mode.

[MODE]

[DIAL]

[TXinh•        ]

Auto RxMSG Disp
ON

Double click then 
select the function 
ON and OFF.

ID-1_ENG_2.qxd  04.9.22 9:29  Page 52 (1,1)



53

7 TRANSMIT AND RECEIVE— VOICE

New2001

� Monitor function
The monitor function releases all squelch mutes, noise
squelch, tone squelch, digital code squelch and digital call
sign squelch, to monitor the signal on the displayed fre-
quency.

➥ Click [MONI] in the application (main screen); or push and
hold [SQL] on the RC-24 to activate the monitor function.
• “MONI” and “ ” appear for FM mode, “MONI” appears for

DV and DD mode operation when the function ON. (main screen)
• “ ” appears on the RC-24 function display while holding [SQL]

for FM operation.
• The displayed frequency shifts when duplex (RP– or RP+) is set.

DD Monitoring mode selection
Under normal settings, an FM mode signal cannot be heard,
even when the monitor is turned ON. There is an exception,
and this is when you have the Digital monitor set to the Ana-
log mode. This will allow an FM mode signal to "Break-in" dur-
ing digital communications. 

• Setting from the application
qDisplays set mode screen by performing one of the follow-

ing operations.
- Select “Edit SetMode(C)...” in view menu.
- Click “ ” button in tool bar.
- Click [SET].
- Press [F7] key on the PC keyboard.

wDouble click “Digital Monitor” cell, then select the desired
monitoring mode from “DIGITAL” and “ANALOG.”
• ANALOG: FM mode, DIGITAL: Digital
• To close the screen, click “ ” or repeat the operation as step q.

Double click the Digital. 
Monitor cell, then select 
the desired monitoring 
mode.

[SQL]

ClickAppears

BUSY
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• Setting from the RC-24
qPush [MODE] several times to select digital mode.
wPush [TXinh• ] for 0.5 sec. to enter set mode.
ePush [MODE] or [TXinh• ] to select “Digital Mon-

itor” item.
rRotate [DIAL] to select the desired monitoring mode.

• ANALOG: FM mode, DIGITAL: Digital
tPush [PWR] momentarily to exit set mode.

LOW

Digital Monitor
DIGITAL

[MODE]

[DIAL]

[TXinh•         ]
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� About D-STAR system
In the D-STAR system, repeater linking via a 10 GHz band
backbone and internet network (gateway connection) capa-
bilities are available. This system allows you to much wider
coverage range during Digital voice mode operation.

• D-STAR system outline

For current existing repeater operation, stations that are com-
municating must be in the same repeater’s operating area.
However, in the D-STAR system as in the illustration at left,
the repeaters can be linked via the system repeaters (with a
10 GHz signal). Thus stations A and B can communicate even
though they are in different repeater operating areas.

Also, the D-STAR system repeaters are connectable through
the internet network— gateway connection capability. 

For example, when station B uses the gateway connection
station B can communicate with the station C! 
By using the gateway connection, long distance communica-
tion like DX operation may be possible with 1.2 GHz digital
voice!

In the D-STAR system, independent repeater’s operating
area is called as Area and a group that linking repeaters via a
10 GHz backbone is called as Zone.

About time-out timer function
The ID-1 has a time-out timer function for digital repeater
operation. The timer limits a continuous transmission for ap-
prox. 10 min. Warning beeps will sound before 30 sec. (ap-
prox.) and just before the timer functioning.

Station A

Repeater A

Repeater D

1.2 GHz signal

Station C

Repeater C

1.2 GHz signal

10 GHz signal

1.2 GHz
signal

Station D

Station B

Repeater B

10 GHz signal

1.2 GHz signal

Internet
network
Internet
network
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� General
Repeaters allow you to extend the operatable range, and also
to cover blind zones. Because a repeater has much higher
output power than the typical transceiver, and has a wider
coverage area.

Normally, a repeater has independent frequency for each re-
ceive and transmit, and a subaudible tone may be required
to accessing a repeater.

Refer to an amateur radio handbook or a ham magazine for
details of local FM repeater, such as repeater input/output fre-
quencies and location.

DD Repeater operation flow chart

• The ID-1 USA version has the auto repeater function. Thus the step 3
(and 4 in FM mode) may not be necessary, depending on the setting.

• Repeater settings can be stored into a memory channel. 

Step 3:
Set the duplex (shift) direction (–duplex or +duplex).
- Set the offset frequency (shift value), if required.

Step 4 for FM mode:
Set the subaudible tone (repeater tone) encoder 
function ON.
- Set the subaudible tone frequency, if required.

Step 1:
Set the desired operating mode.

Step 2:
Set the desired receive frequency (repeater output frequency).

Step 4 for Digital voice mode:
Set the desired repeater call sign.
- Set the desired linked repeater call sign, if required.

Repeater example;
Receives the 1269.975 MHz signal 
and the detected audio signals are 
transmitted on 1289.975 MHz simul-
taneously.

Station A:
Tx: 1269.975 MHz
Rx: 1289.975 MHz

Station B:
Tx: 1269.975 MHz
Rx: 1289.975 MHz
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� Accessing an FM repeater
DD Setting from the application
qClick [MODE] to select FM mode.

• “FM” appears.
wSet the desired receive frequency (repeater output frequency).
eClick [RP] several times to select minus or plus duplex.

• “RP–” or “RP+” appears.
• 12 MHz is set as the default for the USA version. Refer to page

60 for offset frequency setting.
rClick [TONE] to turn the repeater tone encoder ON.

• “TONE” appears.
• 88.5 Hz is set as the default. Refer to page 59 for tone frequency

setting.

NOTE for the USA version: During the auto repeater
function ON, the steps e and r are not necessary, de-
pending on the settings. See page 106 for the auto re-
peater function.

tPush and hold [PTT] to transmit.
• The display frequency automatically changes to the transmit fre-

quency (repeater input frequency).
• If the repeater indicator, “RP–” or “RP+,” and “ ” blink, con-

firm that the duplex direction and the offset frequency (p. 60) is
set correctly.

yRelease [PTT] to receive.
uClick [MONI] to check whether the other station’s transmit

signal can be received directly.
iTo return to simplex operation, click [RP] several times to

clear the “RP–” or “RP+” indicator.
oTo turn OFF the repeater tone encoder, click [TONE] sev-

eral times until no tone indicators appear.

Displays transmit frequency.

Indicates transmit output power level.

Appears during transmit.

Appear Click
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DD Setting from the RC-24
qPush [MODE] to select FM mode.

• “FM” appears.
wSet the desired receive frequency (repeater output frequency).
ePush [RP•4] several times to select minus or plus duplex.

• “RP-” or “RP+” appears.
• 12 MHz is set as the default. Refer to page 60 for offset fre-

quency setting.
rPush [TONE• •5] to turn the repeater tone encoder ON.

• “TONE” appears.
• 88.5 Hz is set as the default. Refer to page 59 for tone frequency

setting.

NOTE for the USA version: During the auto repeater
function ON, the steps e and r are not necessary, de-
pending on the settings. See page 106 for the auto re-
peater function.

tPush and hold [PTT] to transmit.
• The display frequency automatically changes to the transmit fre-

quency (repeater input frequency).
• If the repeater indicator, “RP-” or “RP+” blinks, confirm that the

offset frequency (p. 60) is set correctly.
yRelease [PTT] to receive.

uPush and hold [SQL] to check whether the other station’s
transmit signal can be received directly.

iTo return to simplex operation, push [RP•4] several times to
clear the “RP-” or “RP+” indicator.

oTo turn OFF the repeater tone encoder, push [TONE•
•5] several times until no tone indicators appear.

LOW

FM RP- TONE
00 1294.500

LOW

FM RP- TONE
00 1282.500

During receive

During transmit

LOW

FM RP- TONE
00 1294.500

[MODE]

[RP•4]

[TONE•        •5]
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� Repeater tone frequency setting
DD Setting from the application
qDisplays set mode screen by performing one of the follow-

ing operations.
- Select “Edit SetMode(C)...” in view menu.
- Click “ ” button in tool bar.
- Click [SET].
- Press [F7] key on the PC keyboard.

wDouble click “Repeater Tone” frequency cell, then select
the desired frequency from the displayed list.
• To close the screen, click “ ” or repeat the operation as step q.

DD Setting from the RC-24
qPush [MODE] several times to select FM mode.
wPush [TXinh• ] for 0.5 sec. to enter set mode.
ePush [MODE] or [TXinh• ] to select “Repeater

Tone” item.
rRotate [DIAL] to select the desired tone frequency.

• See the table below for the available frequencies.
tPush [PWR] momentarily to exit set mode.

• Available tone frequencies (unit: Hz)

67.0
69.3
71.9
74.4
77.0

79.7
82.5
85.4
88.5
91.5

94.8
97.4

100.0
103.5
107.2

110.9
114.8
118.8
123.0
127.3

131.8
136.5
141.3
146.2
151.4

156.7
159.8
162.2
165.5
167.9

171.3
173.8
177.3
179.9
183.5

186.2
189.9
192.8
196.6
199.5

203.5
206.5
210.7
218.1
225.7

229.1
233.6
241.8
250.3
254.1

LOW

Repeater Tone
88.5

[MODE]

[DIAL]

[TXinh•         ]

Double click

Appears

Select from the above list.

ID-1_ENG_2.qxd  04.9.22 9:29  Page 59 (1,1)



60

8REPEATER OPERATION— VOICE

New2001

8

� Offset frequency setting
DD Setting from the application
qDisplays set mode screen by performing one of the follow-

ing operations.
- Select “Edit SetMode(C)...” in view menu.
- Click “ ” button in tool bar.
- Click [SET].
- Press [F7] key on the PC keyboard.

wDouble click “Offset Freq” frequency cell, then enter the de-
sired frequency within 0 to 60.000 MHz range.
• To close the screen, click “ ” or repeat the operation as step q.

DD Setting from the RC-24
qPush [MODE] several times to select FM mode.
wPush [TXinh• ] for 0.5 sec. to enter set mode.
ePush [MODE] or [TXinh• ] to select “Offset Fre-

quency” item.
rRotate [DIAL] to set the desired offset frequency.

• The tuning step, previously selected in VFO mode, is used for
the setting.

tPush [PWR] momentarily to exit set mode.

Offset Frequency
12.000

[MODE]

[DIAL]

[TXinh•        ]

Double click, then enter the 
desired offset frequency.
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� Accessing a Digital repeater
DD Setting from the application
qClick [MODE] to select DV (Digital voice) mode.

• “DV” appears.
wSet the desired receive frequency (repeater output frequency).
eClick [RP] several times to select the repeater mode.

• Select “RP–” or “RP+.” 

rClick [CS] to display the Select Call Sign screen, then set
your call sign in “MY.”
• Click [Y]/[Z] to select the programmed your call sign.
• When your call sign is not programmed, enter your call sign into

the text box directly.
tSet the desired station call sign in “YOUR.” 

• When sending a CQ 
- Click [CQ] to displays “CQCQCQ” then click [OK].

• When calling the desired station
- Click [Z] to select the call sign.

• When the desired call sign is not programmed, enter the de-
sired call sign into the text box directly.

ySet the desired near-by repeater call sign in “RPT1” then
click [OK].
• Click [Z] to select the call sign. 
• When the desired repeater call sign is not programmed, enter the

call sign into the text box directly.
• When linking repeaters via internet network (gateway connec-

tion), clicking [G] may be necessary depending on the repeater
system.

uClick “Enable” to display “✔,” then set the near-by repeater
call sign from the desired station in “RPT2” then click [OK],
if necessary.
• Click [Z] to select the call sign. 
• When the desired repeater call sign is not programmed, enter the

call sign into the text box directly.
• When linking repeaters via internet network (gateway connec-

tion), clicking [G] may be necessary depending on the repeater
system.

Click if necessary. Click to shows “✔” and select/enter the
desired repeater call sign, if desired.

Select/enter the desired call sign
; or click to display “CQCQCQ” for CQ call.

Click if necessary.

Appears Click
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iPush and hold [PTT] to transmit; release [PTT] to receive.
oClick [RP] several times until the “RP–” or “RP+” indicator

disappears to return to simplex operation.

Hint!
When using the gateway connection capabilities, the D-STAR
system repeater automatically searches for the nearest re-
peater from the desired station that you want to call even
when you don’t know the desired station is in which Area or
Zone. 

For practical digital repeater operation
When using a digital repeater in digital voice mode, the trans-
mission must be performed after the repeater signal disap-
pears completely. Otherwise the communication error may
occur.

NOTE: The required call sign settings may differ accord-
ing to the repeater system (Area or Zone). Ask the re-
peater system manager for setting details.

How to make a CQ call to another Zone?
When you want to make a CQ call to another Zone, set the
call signs as follows.
e.g.: Another Zone’s repeater call sign= xx0xxx,

the nearest repeater call sign= xx1xxx
the gateway repeater call sign= xx2xxx

q Enter “/xx0xxx” into “YOUR” (or “UR” in RC-24).
w Enter “xx1xxx” into “RPT1” (or “RPT1” in RC-24).
e Enter “xx2xxx_G” into “RPT2” (or “RPT2” in RC-24).

*Some repeater system requires the “G” setting with clicking [G]
in “Select Call Sign” screen or pushing [ ] for 0.5 sec. on RC-
24).
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DD Setting from the RC-24
qPush [MODE] to select DV (Digital voice) mode.

• “DV” appears.
wSet the desired receive frequency (repeater output frequency).
ePush [RP•4] several times to select the repeater mode.

• Select “RP-” or “RP+.” 

rPush [CS• •1] to enter call sign select mode, then rotate
[DIAL] to select the desired station call sign.
• When sending a CQ, push [BK• •.] for 0.5 sec. to displays “ .”
• Refer to the pages 42 to 44 for call sign setting when the desired

call sign is not programmed. 

tPush [CS• •1] one more time to select “RPT1,” then ro-
tate [DIAL] to select the desired repeater call sign.
• Refer to the pages 42 to 44 for call sign setting when the desired

call sign is not programmed. 
• Push [CS• •1] one more times again to select “RPT2” then

set the desired repeater call sign when using the repeater link-
ing capability.

• When linking repeaters via internet network (gateway connec-
tion), pushing [ ] for 0.5 sec. may be necessary depending on
the repeater system.

yPush [CS• •1] once or twice to exit call sign select
mode.

uPush [PTT] to transmit, release [PTT] to receive.
iTo clear “RP-” or “RP+” push [RP•4] once or twice.

LOW

E s00:STATION1 W
RPT1:IDRP01 Gå

[CS•        •1]

[DIAL]LOW

DV RP-
00 1294.500

[MODE]

[RP•4]
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� General
The ID-1 allows you to not only for the voice communications
but also the data communications with Data mode.

The data communication functions as a wireless LAN unit
with up to 128 kbps (theoretical value) of data transmission
speed. Any data files can be copied to the connected PC.

Internet accessing* is also provided with Data mode opera-
tion when gateway connection is used.
*Contract with a gateway repeater manager is additionally required.

� Precaution
R WARNING! The saved file(s) in the shared folder may
be modified or deleted, or unknown file(s) may be copied into
the shared folder from the connected station when the trans-
mission inhibit is released.

Icom Inc. assume no responsibility whatsoever for any dam-
ages or lost profits resulting from opportunities for signal com-
munications being lost because of the failure, malfunction,
poor condition, damage, or data loss of this unit or because of
such external causes as power failure. Icom also dismisses
all responsibility for demands made by a third party.

The transmitting data may be received and decrypted by a
third party/station due to the ID-1 transmits data without en-
cryption.

Connect the ID-1 and PC via Ethernet cable for Data mode
operation in advance. (see p. 17) 

Disconnect the PC from any other network, another ISP, LAN,
etc., is recommended. Network error may be occurred.

For data transferring (PC-to-PC communication), a fixed IP
address must be assigned, the same workgroup setting and
have shared folder must be held for both PCs.

Make sure the Ethernet cable, as well as the coupler connec-
tions are secure. Loose connections may cause a data trans-
mission error during Data operation.
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� Internet access
DD Setting from the application
qClick [MODE] to select DD (Data) mode.

• “DD” appears.
wSet the near-by repeater frequency.
eClick [RP] several times to select “RPS”.

rClick [CS] to display the Select Call Sign screen, set your
call sign in “MY” then click [OK].
• Click [Y]/[Z] to select the programmed your call sign.
• When your call sign is not programmed, enter your call sign into

the text box directly.
tSet the gateway repeater call sign in “YOUR” then click

[OK].
• Click [Z] to select or enter the call sign into the text box directly.

ySet the desired near-by repeater call sign in “RPT1.” 
• Click [Z] to select or enter the call sign into the text box directly.

uSet the gateway repeater call sign in “RPT2” then click
[OK].
• Click [Enable] (“✔” appears) to enable “RPT2” call sign setting.
• Click [Z] to select or enter the call sign into the text box directly.
• When the gateway repeater require the “G” setting, click [G].

NOTE: When the near-by repeater is gateway repeater, set
the call sign into “RPT1” then click [OK], and skip step u.
• When the repeater requires the “G” setting, click [G].

Set the gateway
repeater call sign.

Set the gateway
repeater call sign.*

*See Note below

Set the near-by
repeater call sign.*

Click if necessary.

Set your call sign.

Appears Click
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iClick [TX inh] to release transmission inhibit.
• The transmit inhibit indicator (above [TX inh]) turns OFF.
• Starts accessing to the gateway repeater.

oStart up a web browser then access to the desired web
site.

!0Click [TX inh] again to disconnect (inhibit the transmission)
from the gateway repeater.

Hint!
When starting up an E-mail application at step o, you can
access to the mail server to send or receive an E-mail.

Click
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DD Setting from the RC-24
qPush [MODE] to select DD (Data) mode.

• “DD” appears.
wSet the near-by repeater frequency.
ePush [RP•4] several times to select “RPS.”

• “RPS” displayed briefly.

rPush [CS• •1] to enter call sign select mode, then rotate
[DIAL] to select the gateway repeater call sign.
• Refer to the pages 42 to 44 for call sign setting when the desired

call sign is not programmed. 
tPush [CS• •1] one more time to select “RPT1,” then ro-

tate [DIAL] to select the desired near-by repeater call sign.
• Refer to the pages 42 to 44 for call sign setting when the desired

call sign is not programmed. 
yPush [CS• •1] one more time to select “RPT2,” then ro-

tate [DIAL] to select the gateway repeater call sign.

uPush [ ] for 0.5 sec. to enable the gateway connection,
when the repeater requires the “G” setting.
• “G” appears beside the call sign.

NOTE: When the near-by repeater is gateway repeater,
push [ ] for 0.5 sec. (if necessary) after the call sign set-
ting into “RPT1” in step t and skip step y.

iPush [CS• •1] once (or twice) to exit call sign select
mode.

oPush [TXinh• ] to release transmission inhibit.
• “RPS” appears instead of “TXinh” indication.
• Starts accessing to the gateway repeater.

!0Start up a web browser then access to the desired web
site.

!1Push [TXinh• ] again to disconnect (inhibit the trans-
mission) from the gateway repeater.

LOW

E s00:GATEWY W
RPT2:GATEWY GåG

G

[CS•        •1]

[DIAL]

[    ]

LOW

DD TXinh
00 1294.500

[MODE]

[RP•4]

ID-1_ENG_2.qxd  04.9.22 9:29  Page 67 (1,1)



68

9DATA OPERATION

New2001

9

� Data transferring
NOTE: Set a fixed IP address, the same workgroup and a
shared folder for each PC, as well as the call sign setting
each other for direct data transferring between ID-1s. In
this case, the steps e, t to u are not necessary.

DD Setting from the application
qClick [MODE] to select DD (Data mode).

• “DD” appears.
wSet the desired frequency.
eClick [RP] several times to select “RPS,” when connecting

the PC through repeater/s.
rClick [CS] to display the Select Call Sign screen, set your

call sign in “MY” then click [OK].
• Click [Y]/[Z] to select the programmed your call sign.
• When your call sign is not programmed, enter your call sign into

the text box directly.
tSet the desired station call sign in “YOUR” then click [OK].

• Click [Z] to select or enter the call sign into the text box directly.
For direct data transferring between ID-1s, go to step ii.

ySet the desired near-by repeater call sign in “RPT1,” if de-
sired.
• Click [Z] to select or enter the call sign into the text box directly.

uSet the gateway repeater call sign in “RPT2,” then [OK], if
desired.
• Click [Enable] (“✔” appears) to enable “RPT2” call sign setting.
• Click [Z] to select or enter the call sign into the text box directly.
• When the gateway repeater require the “G” setting, click [G].

NOTE: When the near-by repeater is gateway repeater, set
the call sign into “RPT1” then click [OK], and skip step u.
• When the repeater requires the “G” setting, click [G].

iClick [TX inh] to release transmission inhibit.
• The transmit inhibit indicator (above [TX inh]) turns OFF.
• Starts accessing to the desired station (via repeater/s).

oOpen “Network Computers.”
• The shared folder of the desired station appears.
• It may takes a minutes until the shared folder appears according

to the conditions, or PC performance.
!0Open the shared folder, then drag and drop the desired file

to transferring.
!1Click [TX inh] again to disconnect (inhibit the transmission)

from the connected PC.

Set the desired
station call sign.

Set the gateway
repeater call sign.*

*if desired

Set the near-by
repeater call sign.*

Click if necessary.

Set your call sign.
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DD Setting from the RC-24
qPush [MODE] to select DD (Data) mode.

• “DD” appears.
wSet the desired frequency.
ePush [RP•4] several times to select “RPS,” when connect-

ing the PC through repeater/s.
• “RPS” displayed briefly.

rPush [CS• •1] to enter call sign select mode, then rotate
[DIAL] to select the desired station call sign.
• Refer to the pages 42 to 44 for call sign setting when the desired

call sign is not programmed. 
For direct data transferring between ID-1s, go to step ii.

tPush [CS• •1] one more time to select “RPT1,” then ro-
tate [DIAL] to select the desired near-by repeater call sign,
if desired.
• Refer to the pages 42 to 44 for call sign setting when the desired

call sign is not programmed. 
yPush [CS• •1] one more time to select “RPT2,” then ro-

tate [DIAL] to select the gateway repeater call sign, if de-
sired.

uPush [ ] for 0.5 sec. to enable the gateway connection,
when the repeater require the “G” setting.
• “G” appears beside the call sign.

NOTE: When the near-by repeater is gateway repeater,
push [ ] for 0.5 sec. (if necessary) after the call sign set-
ting into “RPT1” in step t and skip step y.

iPush [CS• •1] once (or twice) to exit call sign select
mode.

oPush [TXinh• ] to release transmission inhibit.
• “RPS” appears instead of “TXinh” indication.
• Starts accessing to the desired PC (via repeater/s).

!0Open “Network Computers.”
• The shared folder of the desired station appears.
• It may takes a minutes until the shared folder appears according

to the conditions, or PC performance.
!1Open the shared folder, then drag and drop the desired file

to transferring.
!2Push [TXinh• ] again to disconnect (inhibit the trans-

mission) from the gateway repeater.
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� Low-speed data communication
In addition to the data communication, a low-speed data com-
munication capability is available.
Low-speed data communications require narrow passband
width, thus digital voice mode is used and provides a simul-
taneous operation with voice and data.

qSet the desired frequency.
wSelect DV (Digital voice) mode.

• Click [MODE] on the main screen or push [MODE] on the RC-
24.

eSet another settings, such as repeater, digital code
squelch, transmit output power.

rClick “ ” or select “Exit(X)” in File menu to quit the appli-
cation.

NOTE: The application must be quit during low-speed data
operation. The application and a low-speed data commu-
nication software cannot be operated simultaneously, due
to both of data passing through the ID-1 USB port.

tStart up the low-speed data communication application.
ySet the application as follows.

• Port : The same COM port number as ID-1’s
• Baud rate : 19200 bps
• Data : 8 bit
• Parity : None
• Stop : 1 bit
• Flow control : Xon/Xoff

uPush and hold [PTT] to transmit, release to receive the
data.
• Refer to the instruction of the application that how to send or re-

ceive data.

NOTE:
• A communication error may occur depending on the com-

bination of the OS used, and the low-speed data commu-
nication application installed in your PC.

• “Packet-loss” (loosing a part of data) may occur when
communicating through internet network. When “Packet-
loss” occurs, [TX/RX] indicator lights orange.

• ASCII code’s characters are only usable.
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� General description
The transceiver has 105 memory channels including 2 scan
edge memory channels (1 pair), and 3 call channels. Each of
these channels can be individually programmed with operat-
ing frequency (pgs. 35, 36), operating mode (p. 38), repeater
mode (pgs. 57, 58, 61–63), offset frequency (p. 60), subaudi-
ble tone encoder or tone squelch and its tone frequency
(p. 59), Digital squelch and its station call sign (pgs. 92–99),
repeater call signs (RPT1 and RPT2; pgs. 61–63), skip infor-
mation* (p. 88) and memory names (pgs 80–82).

*Except scan edges and call channels.

� Memory channel selection
DD Selecting with the application  
qClick [V/M] to select memory mode.

• “MEMO” appears.

• Dial selection
wLeft click or right click on [DIAL] to increase or decrease

the memory channel number. 
• The programmed memories can only be selected.

• Direct channel number input
wClick on [F.INP] to display keypad screen.
eClick the appropriate numeral keys to select the desired

memory channel.
• When selecting a channel 00 to 09, click [0] first then click [0]–[9],

or click [0]–[9] then click [ENT].
• PC keyboard can also be used for the direct channel selection.

• Selecting from Memory Channel screen
wDisplay the Memory channel screen.

- Select “Edit Memory Channel(M)...” in View menu.
- Click “ ” in tool bar.
- Press [F6] key on the PC keyboard.

eDouble click, or right click the desired channel’s “Select”
cell, then select “+ : Move to this CH” to select the desired
memory channel.
• Click the desired memory channel’s “Select” cell, then press

[Enter] while pressing [Ctrl] key on the PC keyboard.

Double click the desired 
channel’s “Select” cell.

Select “+ : Move this CH.”

AppearsClick
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DD Selecting with the RC-24
qPush [V/M] to select memory mode.

• “M” appears beside the channel number indication.

• Dial selection
wRotate [DIAL] to select the desired memory channel.

• The programmed memory channels can only be selected.
• Microphone’s [UP]/[DN] switches can also be used for the selec-

tion.

• Keypad selection
wPush [F.INP•L] then push the appropriate digit keys to se-

lect the desired memory channel.
• Channel number indication disappear after pushing [F.INP•L].
• When selecting a channel 00 to 09, push [AFC• •0] first then

push [AFC• •0]–[MN•9].

� Call channel selection
Call channel is pre-programmed memory channel that can be
accessed by simply clicking call channel button.
The transceiver has 3 call channels.

DD Selecting with the application  
qClick [CALL] to select memory mode.

• “CALL” and “C” appear.

• Dial selection
wLeft click or right click on [DIAL] to increase or decrease

the call channel number. 

• Direct channel number input
wClick on [F.INP] to displays keypad screen.
eClick the appropriate numeral key ([1], [2] or [3]) to select

the desired call channel.
• PC keyboard can also be used for the direct channel selection.

• [CALL] key selection
wClick [CALL] each time to select C1 to C3 in sequence.

“CALL” and “C” appear.Click

LOW

FM
M001294.500

[V/M]

Appears
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• Selecting from Memory Channel screen
wDisplay the Memory channel screen.

- Select “Edit Memory Channel(M)...” in View menu.
- Click “ ” in tool bar.
- Press [F6] key on the PC keyboard.

eDouble click, or right click the desired channel’s “Select”
cell, then select “+ : Move to this CH” to select the desired
call channel.
• Click the desired call channel’s “Select” cell, then press [Enter]

while pressing [Ctrl] key on the PC keyboard.

DD Selecting with the RC-24
qPush [CALL] to select call channel

• “C” appears beside the channel number indication.

• Dial selection
wRotate [DIAL] to select the desired call channel.

• Microphone’s [UP]/[DN] switches can also be used for the selec-
tion.

• Keypad selection
wPush [F.INP•L] then push the appropriate digit key

([CS• •1], [MHz• •2]  or [LOW•3]) to select the de-
sired call channel.
• Channel number indication disappear after pushing [F.INP•L].

• [CALL] selection
wPush [CALL] each time to select C1 to C3 in sequence.

LOW

FM
C11294.500

[CALL]

“C” appears.

Double click the desired 
channel’s “Select” cell.

Select “+ : Move to this CH”.
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� Programming a memory/call channel 
VFO settings, including the set mode contents such as re-
peater tone frequency, offset, can be programmed into a
memory and call channel.

DD Programming from the application
— main screen

qSet the desired frequency in VFO mode.
➥ Set the operating mode with [MODE].
➥ Set the frequency using [DIAL] or keypad.
➥ Set other data (e.g. station call sign, tone information,

etc.) if required.
wClick [MW] to display the Memory programming screen.

eSelect the desired memory or call channel number by right
clicking or left clicking on the [DIAL] in the screen.
• Click “MEMORY” to select memory, or click “CALL” to select call

channel.

rClick [MW] on the Memory programming screen to pro-
gram.

tTo close the Memory programming screen, click [MW] on
the main screen again or click “ .”

Click

Click to
select

Shows the selected memory 
or call channel number and 
previously programmed fre-
quency.

Right click to move memory 
or call channel number up.
Left click to move memory or 
call channel number down.

Click
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DD Programming from the application
— Memory Channel screen

qDisplay the Memory channel screen.
- Select “Edit Memory Channel(M)...” in View menu.
- Click “ ” in tool bar.
- Press [F6] key on the PC keyboard.

wClick to select the “Freq.” cell of desired memory or call
channel, then enter the desired operating frequency from
the PC keyboard directly.

eDouble click the Mode cell in the same memory/call chan-
nel, then select the desired operating mode.

rSet the other items as follows.
• Repeaters— RP

Double click the cell, then select the
desired duplex condition.

• Repeaters— Offset Freq.
Click to select the cell, then enter the desired offset fre-
quency from the PC keyboard directly.

• TONE/TSQL— Tone Select
Double click the cell, then select the
desired tone condition.

• TONE/TSQL— Repeater Tone, TSQL Tone
Double click the cell, then select the
desired tone frequency.

• Digital— DSQL
Double click the cell, then select the
desired digital squelch condition.

• Digital— Code
Click to select the cell, then enter the desired digital code
number from the PC keyboard directly.

Double click the 
Mode cell, then 
select the desired 
operating mode.

Click to select, then 
enter the desired 
operating frequency.
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• Call Sign— YOUR, RPT1, RPT2
Click to select the cell, then enter the desired station or
repeater call sign from the PC keyboard directly.

• SKIP

Double click then select the skip condition.
• Not selectable for the scan edges and call channels.

• Memory Name 
Click to select the cell, then enter the desired memory
name from the PC keyboard directly.

tRepeat the steps w to r to program another memory or
call channels.

yTo close the Memory Channel screen, click “ ” in tool bar
or click “ .”

DD Programming with the RC-24
qSet the desired frequency in VFO mode.

➥ Set the operating mode with [MODE].
➥ Set the frequency using [DIAL] or keypad.
➥ Set other data (e.g. station call sign, tone information,

etc.), if required.
wPush [MW•6] momentarily.

• The previously selected memory channel number blinks.

eRotate [DIAL] to select the desired memory/call channel to
be programmed.
• Push [V/M] to select the previously selected memory channel

(the same memory channel as displayed at step w), push [CALL]
to select call channel 1.

• Select “MC1” as the call channel 1, “MC2” as the call channel 2
and “MC3” as the call channel 3.

rPush [MW•6] for 0.5 sec. to program.
• 3 beeps sound.
• Memory channel number automatically increases when continu-

ing to push [MW•6] after programming.

LOW

FM
M001294.500

[MW•6]
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� Copying a memory contents
This function copies a memory channel’s contents to VFO (or
another memory/call channel). This is useful when searching
for signals around a memory channel frequency and for re-
calling the offset frequency, subaudible tone frequency etc.

DD Copying from the application
— main screen

qSelect the desired memory/call channel to be copied with
[DIAL] or keypad.
• Click [V/M] or [CALL] to select memory or call channel, if necessary.

wClick [MW] to display the Memory programming screen.
eClick to select the desired mode (MEMORY, CALL or VFO)

to be copied to.
rSelect the desired memory or call channel number by right

clicking or left clicking on the [DIAL] in the screen.

tClick [MW] on the Memory programming screen to copy.
yTo close the Memory programming screen, click [MW] on

the main screen again or click “ .”

DD Copying from the application
— Memory Channel screen

qDisplay the Memory channel screen.
- Select “Edit Memory Channel(M)...” in View menu.
- Click “ ” in tool bar.
- Press [F6] key on the PC keyboard.

wRight click any cell of the desired memory/call channel to
be copied, except “Select,” then select “Copy(C)” from the
displayed menu as below.
• After selecting a cell of the desired memory channel, press [C]

key while [Ctrl] key is pressed and held— these key actions are
the same as the mouse operation above.

eRight click any cell of the desired memory/call channel to
be copied to, except “Select,” then select “Paste(V).”
• After selecting a cell of the desired memory channel, press [V]

key while [Ctrl] key is pressed and held— these key actions are
the same as the mouse operation above.

NOTE: Copying a memory/call channel contents to VFO is
not possible from the Memory Channel screen. 

Select to copy.
Select to paste.

Click to
select

Shows the selected memory 
channel number and previ-
ously programmed frequency.

Right click to move memo-
ry channel number up.
Left click to move memory 
channel number down.
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DD Copying with the RC-24
qSelect the desired memory or call channel with [DIAL] or

keypad to be copied.
• Push [V/M] or [CALL] to select memory mode or call channel, if

desired.
wPush [MW•6] momentarily.

• The previously selected memory channel number blinks.

eRotate [DIAL] to select VFO, the desired memory or call
channel to be programmed.
• Select “M--” when copying to VFO.
• Select “M00” to “M99” when copying to memory channel.
• Select “MC1” to “MC3”  when copying to call channel.
• The display shows the currently programmed frequency and set-

tings.
• Push [V/M] to select a blank memory channel, push [CALL] to

select call channel 1.
rPush [MW•6] for 0.5 sec. to program.

• 3 beeps sound.

� Memory clearing 
Contents of programmed memories can be cleared (blanked),
if desired.

DD Clearing from the application
— main screen

qClick [MW] to display the Memory programming screen.
wClick to select the “MEMORY.”
eSelect the desired memory channel number to be cleared

by right clicking or left clicking on the [DIAL] in the screen.

rClick [M-CL] on the Memory programming screen to clear
the contents.

tTo close the Memory programming screen, click [MW] on
the main screen again or click “ .”

Click to
select.

Shows the selected memory 
channel number and previ-
ously programmed frequency.

Right click to move memo-
ry channel number up.
Left click to move memory 
channel number down.

LOW

FM
M001294.500

[MW•6]
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DD Clearing from the application
— Memory Channel screen

qDisplay the Memory channel screen.
- Select “Edit Memory Channel(M)...” in View menu.
- Click “ ” in tool bar.
- Press [F6] key on the PC keyboard.

wRight click any cell of the desired memory channel to be
cleared, except “Select,” then select “Clear” from the dis-
played menu as below.

DD Clearing with the RC-24
qPush [V/M] to select VFO mode.
wPush [MW•6] momentarily.

• “M--” blinks.
eSelect the desired memory channel with [DIAL] or keypad

to be cleared.
rPerform the following operations within 2 sec.

- Push [MW•6] momentarily.
- Push [MW•6] for 0.5 sec. again.
• The programmed frequency disappears and the selected mem-

ory channel number blinks.

Select to clear.

✔ For your convenience— Memory Chan-
nel screen other operations

qMove to above (Press [Ctrl] and [⇑] keys at the same time)
swaps the selected Memory Channel with the Channel
above it.

wMove to below (Press [Ctrl] and [⇓] keys at the same time)
swaps the selected Memory Channel with the Channel
below it.

eDelete [Del]
Deletes the selected Memory Channel and moves the
Memory Channels up one Memory Channel location.

r Insert [Ins]
Inserts an empty Memory Channel above the selected
Memory Channel and moves the Memory Channels down
one Memory Channel location. 

q
w

e
r
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� Programming memory name 
Each memory channel can be programmed with an alphanu-
meric channel name for easy recognition and can be indicated
independently by channel. Names can be a maximum of 10
characters.

DD Programming from the application
qDisplay the Memory Channel screen.

- Select “Edit Memory Channel(M)...” in View menu.
- Click “ ” in tool bar.
- Press [F6] key on the PC keyboard.

wClick to select “Memory Name” cell of the desired memory
channel.

eType the desired 10-character memory name from the PC
keyboard.

rTo close the Memory Channel screen, click “ ” on the
main screen or repeat the step q.

DD Programming with the RC-24
qPush [V/M] to select memory mode.
wSelect the desired memory channel with [DIAL] or keypad.
ePush [MN•9] for 0.5 sec. to enter memory name program-

ming condition.
• 1 short and 1 long beep will sound.

rPush [CALL] or [MODE] to select the digit to be edited.
• Pushing [CALL] moves the cursor to left; pushing [MODE] moves

cursor to right.

[CALL]

[MODE]

LOW

ç å A AB
Name:

[MN•9]

Click to select then 
type the desired 
memory name.
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tPush [SQL] several times to select the desired character
group, then rotate [DIAL] to select the desired character.
• AB : Alphabets (Capital: A to Z)
• ab : Alphabets (Small letter: a to z)
• 12 : Numbers (0 to 9)
• _/ : Symbols (space and /)
• !" : Symbols (! “ # $ % & ’ ( ) ✱ + , – . : ; < = > ? @ [ \ ] ^ _ ` {

| } ~)

yPush [TXinh• ] to enter the selected character.
• The cursor move to right automatically.

uRepeat the steps r to y to enter the desired memory
name.

iPush [MN•9] for 0.5 sec. to program the memory name and
exit the edit condition.
• 1 short and 1 long beep will sound.
• Return to memory mode automatically.

oRepeat steps w to i to program another memory names.

ç å 1 12
Name:Icom ID-1

ç å A AB
Name:

[SQL]

Shows the selected character.
Shows the selected character group.

[DIAL]
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� Memory name indication
During memory mode operation, the programmed memory
name can be displayed instead of the programmed frequency
for your preference.

DD Selecting from the application
qClick [V/M] to select memory mode, if necessary.

• “MEMO” appears.
wClick [MN] to show the programmed memory name.

• “MN” appears.
• When no memory name is programmed, the programmed fre-

quency is displayed.
eTo cancel the indication, click [MN] again.

DD Selecting with the RC-24
qPush [V/M] to select memory mode.
wSelect the desired memory channel with [DIAL] or keypad.
ePush [MN•9] momentarily to toggle the indication between

programmed memory name and frequency.
• “MN ON” or “MN OFF” displayed for a while when memory

name indication or frequency indication is selected, respectively.

LOW

FM
1294.500 M00

LOW

FM
Icom ID-1 M00

[MN•9]

Selected with [MN•9].

ClickToggles indication with [MN].
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� Scan types
Scanning searches for signals automatically and makes it
easier to locate new stations for contact or listening purposes.

There are 3 scan types and 4 resume conditions to suit your
operating needs.

MODE SELECT SCAN 
Repeatedly scans all memory
channels with the selected op-
erating mode.

FMDV DV

DV

DVDVDV

DD

M 00 M 04

M 01 M 02 M 03

M 05M 99 M 06

PROGRAMMED SCAN
Repeatedly scans between
two user-programmed fre-
quencies. Used for checking
for frequencies within a speci-
fied range such as repeater
output frequencies, etc. 

Band
edge

Band
edge

Scan edges

Scan

Jump

MPA MPB
Start End

MEMORY SCAN Repeatedly scans memory
channels except those set as
skip channels. Used for often-
called channels and for by-
passing normally busy
channels such as repeater
frequencies.

SKIP

SKIP

M 00 M 04

M 01 M 02 M 03

M 05M 99 M 06

SCAN RESUME
CONDITION (p. 89)

4 resume conditions are avail-
able: 3 timer scans and pause
scan. When receiving  a sig-
nal, pause scan pauses until
the signal disappears; timer
scans pause for 5, 10 or
15 sec.

Pause
scan

Receiving
a signal

Timer
scan

Pausing

2 sec.
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� Scan start/stop
DD Preparation
Set the scan resume condition (p. 89); program the scan
edges (pgs. 85–87); program 2 or more memory channels
(pgs. 74–76); set skip settings (p. 88), if desired.

DD Scanning from the application
qSelect VFO mode for programmed scan; or memory mode

for memory/mode select scan with [V/M].
• Select a memory channel which the desired operating mode is

programmed.
wClick [SCAN].

eSelect the desired scan type.
• After the selection, the selected scan starts.

*The above list indication is for instruction description only. In the
actual application clearly shows the selectable items only.

rTo cancel the scan, click [SCAN] again then select “OFF.”

DD Scanning with the RC-24
qSelect VFO when programmed scan; or select memory

mode when memory/select mode scan with [V/M].
• Select a memory channel which the desired operating mode is

programmed.
wPush [SCAN•8] momentarily to start programmed or mem-

ory scan; push [SCAN•8] for 0.5 sec. to start select mode
scan.
• Decimal point, “.”, blinks during programmed scan; “M” indica-

tor blinks during memory/select mode scan.

eTo cancel the scan, push [SCAN•8] momentarily.

[SCAN•8]

Selectable when VFO has been 
selected.
Selectable when memory mode 
has been selected.

Click
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� Programming scan edge channels 
Scan edges can be programmed in the same manner as
memory channels. Scan edges are programmed into scan
edges PA and PB, in memory channels.

DD Programming from the application
— main screen

qSet the desired scan start frequency in VFO mode.
➥ Set the operating mode with [MODE]
➥ Set the frequency using [DIAL] or keypad.
➥ Set other data (e.g. station call sign, tone information,

etc.) if required.
wClick [MW] to display the Memory programming screen.

eSelect the memory channel “PA” by right clicking or left
clicking on the [DIAL] in the screen.
• Click to select “MEMORY” if call is selected.

rClick [MW] on the Memory programming screen to pro-
gram.

tSet the desired scan end frequency in VFO mode as the
step q.

ySelect the memory channel “PB,” then click [MW] in Mem-
ory programming screen to program.

uTo close the Memory programming screen, click [MW] on
the main screen again or click “ .”

Click

Click to
select.

Shows the selected scan 
edge channel and previously 
programmed frequency.

Select “PA” or “PB” 
channel.

Click
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DD Programming from the application
— Memory Channel screen

qDisplay the Memory channel screen.
- Select “Edit Memory Channel(M)...” in View menu.
- Click “ ” in tool bar.
- Press [F6] key on the PC keyboard.

wClick to select the “Freq.” cell of either the scan edge chan-
nel, PA or PB, then enter the desired operating frequency
from the PC keyboard directly.

eDouble click the Mode cell in the same memory/call chan-
nel, then select the desired operating mode.

rSet the other items as follows.
• Repeaters— RP

Double click the cell, then select the
desired duplex condition.

• Repeaters— Offset Freq.
Click to select the cell, then enter the desired offset fre-
quency from the PC keyboard directly.

• TONE/TSQL— Tone Select
Double click the cell, then select the
desired tone condition.

• TONE/TSQL— Repeater Tone, TSQL Tone
Double click the cell, then select the
desired tone frequency.

• Digital— DSQL
Double click the cell, then select the
desired digital squelch condition.

• Digital— Code
Click to select the cell, then enter the desired digital code
number from the PC keyboard directly.

Double click the 
Mode cell, then 
select the desired 
operating mode.

Click to select, then enter 
the desired scan edge 
frequency.
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• Call Sign— YOUR, RPT1, RPT2
Click to select the cell, then enter the desired station or
repeater call sign from the PC keyboard directly.

• Memory Name 
Click to select the cell, then enter the desired memory
name from the PC keyboard directly.

tRepeat the steps w to r to program another scan edge
channel.

yTo close the Memory Channel screen, click “ ” in tool bar
or click “ .”

DD Programming with the RC-24
qSet the desired scan edge frequency in VFO mode.

➥ Set the operating mode with [MODE]
➥ Set the frequency using [DIAL] or keypad.
➥ Set other data (e.g. station call sign, tone information,

etc.) if required.
wPush [MW•6] momentarily.

• Memory channel number blinks.

eRotate [DIAL] to select a scan edge channel to be pro-
grammed.
• Select “MPA” as the PA, “MPB” as the PB channel.

rPush [MW•6] for 0.5 sec. to program.
• 3 beeps sound.
• Scan edge channel number automatically increases when con-

tinuing to push [MW•6] after programming.
tRepeat the steps q to r to program the another scan

edge channel.

[MW•6]
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� Skip channel setting
The memory skip function speeds up scanning by checking
only those memory channels not set as skip channels. Set
skip channels as follows.

DD Setting from the application
qDisplay the Memory channel screen.

- Select “Edit Memory Channel(M)...” in View menu.
- Click “ ” in tool bar.
- Press [F6] key on the PC keyboard.

wDouble click the “SKIP” cell of the desired memory chan-
nel, then select the skip condition from “OFF” and “SKIP.”
• “SKIP” indicator appears on the main screen when “SKIP” is se-

lected.
• Scan edge and call channels cannot be selected as the skip

channel.

eRepeat the step w to set the skip condition for another
memory channels, if desired.

DD Setting from the RC-24
qSelect the desired memory channel.

➥ Push [V/M] to select memory mode.
➥ Select the desired memory channel number with [DIAL]

or keypad.
wPush [PRIO• •7] for 0.5 sec. to turn the skip setting ON

and OFF.
• “ ” appears when the skip setting ON.

LOW

FM
1294.500 M00

[PRIO•        •7]

Appears
Double click then select the

desired skip condition.
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� Scan resume condition
[

The scan resume condition can be selected as timer or pause
scan. The selected resume condition is also used for priority
watch. (pgs. 86, 87)

DD Setting from the application
qDisplay the Set Mode screen.

- Select “Edit Set Mode(C)...” in View menu.
- Click “ ” in tool bar.
- Press [F7] key on the PC keyboard.

wDouble click the “Scan Resume Timer” cell, then select the
desired scan resume condition from “P-2,” “T-5,” “T-10” and
“T-15.”

• Resuming conditions
• “P-2” : Scan pauses until the signal disappears and then re-

sumes 2 sec. later.
• “T-5” : Scan pauses 5 sec. while receiving a signal.
• “T10” : Scan pauses 10 sec. while receiving a signal.
• “T-15” : Scan pauses 15 sec. while receiving a signal.

eTo close the Set Mode screen, click “ ” in tool bar or click
“ .”

DD Setting from the RC-24
qPush [TXinh• ] for 0.5 sec. to enter set mode.
wPush [MODE] or [TXinh• ] several times to select “Scan

Timer” item.
• Select “ON” for “Extension” item in advance.

eRotate [DIAL] to select the desired scan resume condition.
• See “•Resuming conditions” above.

rPush [PWR] momentarily to exit set mode.

Scan Timer
T-10

[MODE]
[TXinh•         ]

Double click
then select the desired
scan resume condition.
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� Priority watch types
Priority watch checks for signals on a VFO frequency every
5 sec. while operating in memory mode. The transceiver has
2 priority watch types to suit your needs. You can also trans-
mit on the VFO frequency while the priority watch operates.

The watch resumes according to the selected scan resume
condition. See previous page for details.

� NOTES: If the pocket beep function is activated, the trans-
ceiver automatically selects the tone squelch function
when priority watch starts.

MEMORY CHANNEL
WATCH
While operating on a VFO fre-
quency, priority watch checks for
a signal on the selected memory
channel every 5 sec.

CALL CHANNEL WATCH
While operating on a VFO fre-
quency, priority watch checks for
signals on the call channel every
5 sec.

5 sec.

VFO
frequency

50 msec.
Memory
channel

5 sec.

VFO
frequency

50 msec.
Call

channel

� Priority watch operation
DD Operating from the application
qSelect VFO mode; then, set an operating frequency.
wSet the watch channel(s).

For memory channel watch:
Select the desired memory channel.
For call channel watch:
Select the desired call channel by clicking [CALL], then
click (left or right) on the [DIAL].

eClick [PRIO] to start the watch.
• “PRIO” appears during priority watch.
• The transceiver checks the memory or call channel every 5 sec.
• The watch resumes according to the selected scan resume con-

dition. (p. 89)
• While the watch is pausing, clicking the [PRIO] resumes the

watch manually.

rClick [PRIO] again to stop the watch.

ClickAppears during priority watch.
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DD Operating from the RC-24
qSelect VFO mode; then, set an operating frequency.
wSet the watch channel(s).

For memory channel watch:
Select the desired memory channel.
For call channel watch:
Select the desired call channel by clicking [CALL], then
click (left or right) on the [DIAL].

ePush [PRIO• •7] to start the watch.
• “p” blinks during priority watch
• The transceiver checks the memory or call channel every 5 sec.
• The watch resumes according to the selected scan resume con-

dition. (p. 89)

rPush [PRIO• •7] again to stop the watch.

LOW

FM
00p1294.500

[PRIO•        •7]
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� Pocket beep operation
This function uses subaudible tones in FM; digital code or call
sign in Digital voice mode for calling and can be used as a
“common pager” to inform you that someone has called while
you were away from the transceiver.

In addition, if the received signal includes matched digital
code, any calls, even a CQ call, can be received when using
the pocket beep function with digital code. However, when
using the call sign squelch for the pocket beep, the signal that
containing your call sign (when another station calling you)
can only be received.

DD Setting from the application
qSet the desired operating frequency and mode (FM or Dig-

ital voice).

• Using the CTCSS — in FM mode
wDisplays the Set Mode screen.

- Select “Edit Set Mode(C)...” in View menu.
- Click “ ” in tool bar.
- Press [F7] key on the PC keyboard.

eDouble click the “CTCSS Tone” cell, then select the desired
tone frequency.

rClick [TONE] (FM mode) once or twice until “PBEEP” ap-
pears to turn the pocket beep function ON.

tWhen a signal with matched tone signal is received;
- The transceiver emits beep tones.
- Shows “PBEEP” and “ ” indications alternately.

yPush [PTT] to answer.
• The pocket beep function is cancelled and the tone squelch or

digital code squelch operation is selected automatically.
• “TSQL” indication appears instead of “PBEEP.”

uClick [TONE] once to cancel the tone squelch function.
• “TSQL” indication disappears.

PBEEP

Double click, then
select the desired
tone frequency.

ID-1_ENG_2.qxd  04.9.22 9:30  Page 92 (1,1)



93

13 POCKET BEEP AND TONE/DIGITAL SQUELCH 

New2001

• Using the digital code squelch— in Digital voice mode
wDisplays the Set Mode screen.
eDouble click the “Digital Code” cell, then enter the desired

code number within 00 to 99.

rClick [DSQL] several times until “CBEEP” appears to turn
the pocket beep function ON.

tWhen a signal with matched digital code is received;
- The transceiver emits beep tones.
- Shows “CBEEP” and “ ” indications alternately.

yPush [PTT] to answer.
• The pocket beep function is cancelled and the digital code

squelch operation is selected automatically.
• “CSQL” indication appears instead of “CBEEP.”
• When the called station call sign is not selected in “YOUR” (in

Select Call Sign screen), click [CD] to display Received Call
Record screen, select the call then click [Select] to set the call
sign before pushing [PTT].

uClick [DSQL] several times to cancel the digital code
squelch function.
• “CSQL” indication disappears.

• Using the call sign squelch— in Digital voice mode
wClick [CS] to display Select Call Sign screen.
eSelect or enter the desired call sign in “MY.”

• After the setting, click [OK].

rClick [DSQL] several times until “DBEEP” appears to turn
the pocket beep function ON.

tWhen the signal with matched call sign is received;
- The transceiver emits beep tones.
- Shows “DBEEP” and “ ” indications alternately.

yPush [PTT] to answer.
• The pocket beep function is cancelled and the call sign squelch

operation is selected automatically.
• “DSQL” indication appears instead of “DBEEP.”
• When the called station call sign is not selected in “YOUR” (in

Select Call Sign screen), click [CD] to display Received Call
Record screen, select the call then click [Select] to set the call
sign before pushing [PTT].

uClick [DSQL] several times to cancel the call sign squelch
function.
• “DSQL” indication disappears.

DBEEP

Select/enter the desired call sign.

CBEEP

Enter the desired
code number.
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DD Setting from the RC-24
qSet the desired operating frequency and mode (FM or Dig-

ital voice).

• Using the CTCSS— in FM mode
wPush [TXinh• ] for 0.5 sec. to enter set mode.
ePush [MODE] or [TXinh• ] several times to select

“CTCSS Tone” item.

rRotate [DIAL] to select the desired tone squelch frequency.
• After the selection, push [PWR] momentarily to exit set mode.

tPush [TONE• •5] once or twice to turn the pocket beep
function ON.
• “ ” and “TSQL” appear.

yWhen a signal with matched tone is received the trans-
ceiver emits beep tones and “ ” indicator blinks.

uPush [PTT] to answer.
• “ ” indicator disappears.

iPush [TONE• •5] once to cancel the tone squelch func-
tion.
• “TSQL” disappears.

• Using the digital code squelch— in Digital voice mode
wPush [TXinh• ] for 0.5 sec. to enter set mode.
ePush [MODE] or [TXinh• ] several times to select

“Digital Code” item.

rRotate [DIAL] to select the desired code number.
• After the selection, push [PWR] momentarily to exit set mode.

tPush [TONE• •5] several times until “ ” and “CSQL”
appear to turn the pocket beep function ON.

yWhen a signal with matched digital code is received;
- The transceiver emits beep tones.
- “ ” indicator blinks.

uPush [PTT] to answer.
• “ ” indicator disappears.
• When the called station call sign is not selected in “UR,” push

[CS• •1] for 0.5 sec. to display receive call sign indication
mode then push [SQL] for 0.5 sec. to set the call sign before
pushing [PTT].

iPush [TONE• •5] once to cancel the digital code
squelch function.
• “CSQL” disappears.

Digital Code
00

CTCSS Tone
88.5

[MODE]
[TXinh•         ]
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• Using the call sign squelch— in Digital voice mode
wPush [CS• •1] 4 times (“MY” selection), then rotate dial

to select the desired call sign.

ePush [CS• •1] again to exit call sign selecting condition.
rPush [TONE• •5] several times until “ ” and “DSQL”

appear to turn the pocket beep function ON.
tWhen a signal with matched call sign is received the trans-

ceiver emits beep tones and “ ” indicator blinks.
yPush [PTT] to answer.

• “ ” indicator disappears.
• When the called station’s call sign is not selected in “UR,” push

[CS• •1] for 0.5 sec. to display receive call sign indication
mode then click [SQL] for 0.5 sec. to set the call sign before
pushing [PTT].

uPush [TONE• •5] once to cancel the call sign squelch
function.
• “DSQL” disappears.

LOW

E /
MY :0

[CS•        •1]
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� Tone/Digital code/call sign squelch operation
The tone, digital code or call sign squelch opens only when
receiving a signal with the same pre-programmed subaudible
tone, digital code or call sign, respectively.

DD Setting from the application
qSet the desired operating frequency and mode (FM or Dig-

ital voice).

• Using the CTCSS — in FM mode
wDisplays the Set Mode screen.

- Select “Edit Set Mode(C)...” in View menu.
- Click “ ” in tool bar.
- Press [F7] key on the PC keyboard.

eDouble click the “CTCSS Tone” cell, then select the desired
tone frequency.

rClick [TONE] once or twice until “TSQL” appears to turn the
tone squelch function ON.

tWhen a signal with matched tone signal is received the
squelch opens and the signal can be heard.
• When the received signal includes an unmatched tone, the

squelch does not open. However, the S/RF indicator shows the
received signal strength.

yPush [PTT] to answer.
uClick [TONE] once to cancel the tone squelch function.

• “TSQL” indication disappears.Double click, then
select the desired
tone frequency.
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• Using the digital code squelch— in Digital voice mode
wDisplays the Set Mode screen.
eDouble click the “Digital Code” cell, then enter the desired

code number within 00 to 99.

rClick [DSQL] several times until “CSQL” appears to turn
the pocket beep function ON.

tWhen a signal with matched digital code is received, the
squelch opens and the signal can be heard.
• When the received signal includes an unmatched code, the

squelch does not open. However, the S/RF indicator shows the
received signal strength.

yOperate the transceiver in the normal way (push [PTT] to
transmit; release to receive).
• When the called station’s call sign is not selected in “YOUR” (in

Select Call Sign screen), click [CD] to display Received Call
Record screen, select the call then click [Select] to set the call
sign before pushing [PTT].

uClick [DSQL] several times to cancel the digital code
squelch function.
• “CSQL” indication disappears.

• Using the call sign squelch— in Digital voice mode
wClick [CS] to display Select Call Sign screen.
eSelect or enter the desired call sign in “MY.”

• After the setting, click [OK].

rClick [DSQL] several times until “DSQL” appears to turn
the call sign squelch function ON.

tWhen a signal with matched call sign is received, the
squelch opens and the signal can be heard.
• When the received signal includes an unmatched call sign, the

squelch does not open. However, the S/RF indicator shows the
received signal strength.

yOperate the transceiver in the normal way (push [PTT] to
transmit; release to receive).
• When the called station’s call sign is not selected in “YOUR” (in

Select Call Sign screen), click [CD] to display Received Call
Record screen, select the call then click [Select] to set the call
sign before pushing [PTT].

uClick [DSQL] several times to cancel the call sign squelch. 
• “DSQL” indication disappears.

Select/enter the desired call sign.Enter the desired
code number.
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DD Setting from the RC-24
qSet the desired operating frequency and mode (FM or Dig-

ital voice).

• Using the CTCSS— in FM mode
wPush [TXinh• ] for 0.5 sec. to enter set mode.
ePush [MODE] or [TXinh• ] several times to select

“CTCSS Tone” item.

rRotate [DIAL] to select the desired tone squelch frequency.
• After the selection, push [PWR] momentarily to exit set mode.

tPush [TONE• •5] once or twice to turn the tone squelch
function ON.
• “TSQL” appear.

yWhen a signal with matched tone is received, the squelch
opens and emits received signal.
• When the received signal includes an unmatched tone, the

squelch does not open. However, the S/RF indicator shows the
received signal strength.

uPush [PTT] to answer.

iPush [TONE• •5] once to cancel the tone squelch func-
tion.
• “TSQL” disappears.

• Using the digital code squelch— in Digital voice mode
wPush [TXinh• ] for 0.5 sec. to enter set mode.
ePush [MODE] or [TXinh• ] several times to select

“Digital Code” item.

rRotate [DIAL] to select the desired code number.
• After the selection, push [PWR] momentarily to exit set mode.

tPush [TONE• •5] several times “CSQL” appears to turn
the digital code squelch function ON.

yWhen a signal with matched digital code is received, the
squelch opens and emits received signal.
• When the received signal includes an unmatched code, the

squelch does not open. However, the S/RF indicator shows the
received signal strength.

uPush [PTT] to answer.
• When the called station call sign is not selected in “UR,” push

[CS• •1] for 0.5 sec. to display receive call sign indication
mode then push [SQL] for 0.5 sec. to set the call sign before
pushing [PTT].

Digital Code
00

CTCSS Tone
88.5

[MODE]
[TXinh•         ]
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iPush [TONE• •5] once to cancel the digital code
squelch function.
• “CSQL” disappears.

• Using the call sign squelch— in Digital voice mode
wPush [CS• •1] 4 times (“MY” selection), then rotate dial

to select the desired call sign.

ePush [CS• •1] again to exit call sign selecting condition.
rPush [TONE• •5] several times until “DSQL” appears to

turn the call sign squelch function ON.
tWhen a signal with matched call sign is received, the

squelch opens and emits received signal.
• When the received signal includes an unmatched call sign, the

squelch does not open. However, the S/RF indicator shows the
received signal strength.

yPush [PTT] to answer.
• When the called station’s call sign is not selected in “UR,” push

[CS• •1] for 0.5 sec. to display receive call sign indication
mode then push [SQL] for 0.5 sec. to set the call sign before
pushing [PTT].

uPush [TONE• •5] once to cancel the call sign squelch
function.
• “DSQL” disappears.

LOW

E /
MY :0

[CS•        •1]
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� Set mode
DD Set mode operation with the application
qSelect “Edit Set Mode(C)...” in View menu, click “ ” in tool

bar or press [F7] key on the PC keyboard.
• Set Mode screen appears.

wDouble click the desired item, then select or enter the de-
sired value or condition.

eTo close the Set Mode screen, click “ ” in tool bar, click
“ ” or press [F7] key.

DD Set mode operation with the RC-24
qPush [TXinh• ] for 0.5 sec. 
wPush [MODE] or [TXinh• ] to select the desired item.
eRotate [DIAL] to select the desired value or condition.
rTo exit set mode, push [PWR] momentarily.

DD Offset Freq. (Offset Frequency)
Sets the duplex offset frequency within 0 to 60 MHz range.
During duplex (repeater) operation, transmit frequency shifts
the set frequency. (default value may differ depending on versions)

Offset Frequency
12.000
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DD Digital Code (Digital Code)
� This item appears only when entering set mode from digi-

tal modes.
Sets the desired digital code for digital code squelch opera-
tion. Total of 100 codes (00–99) are available. (default: 00)

DD Digital Monitor (Digital Monitor)
� This item appears only when entering set mode from digi-

tal modes.
Sets the desired monitoring mode during digital mode opera-
tion from “DIGITAL” and “ANALOG.” (default: DIGITAL)
Select “ANALOG” when using FM mode for monitoring.

DD Repeater Tone (Repeater Tone)
� This item appears only when entering set mode from FM

mode.
Sets subaudible tone frequency (encoder only) for repeater
operation. Total of 50 tone frequencies (67.0–254.1 Hz) are
available. (default: 88.5 Hz)

DD CTCSS Tone (CTCSS Tone)
� This item appears only when entering set mode from FM

mode.
Sets subaudible tone frequency (both encoder and decoder)
for tone squelch operation. Total of 50 tone frequencies
(67.0–254.1 Hz) are available. (default: 88.5 Hz)

CTCSS Tone
88.5

Repeater Tone
88.5

Digital Monitor
DIGITAL

Digital Code
00
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DD Scan Resume Timer (Scan Timer)
Selects scan resume timer from T-15, T-10 (default), T-5 and
P-2. 

• SCT-15/10/5 : Scan pauses for 15/10/5 sec., then re-
sumes.

• SCP-2 : Pause on a signal until signal disap-
pears, then resumes 2 sec. after the sig-
nal disappears.

DD Standby Beep (Standby Beep)
� This item appears only when entering set mode from Dig-

ital modes.
Turns the beep emission capability when the communicating
station finishes transmitting or the receive signal disappears.

(default: ON) 

DD Auto Reply (Auto Reply)
� This item appears only when entering set mode from Dig-

ital modes.
During Digital mode operation, auto reply function is avail-
able. This function replies to an individual station call even
you are away from the transceiver.
After the manual transmission (pushing [PTT]), the Auto
Reply setting is return to OFF automatically. 

(default: OFF)

DD Auto RxCall Reg. (Auto RxCall Reg.)
� This item appears only when entering set mode from Dig-

ital modes.
When an individual station call is received, the calling station
call sign can be stored automatically. The stored call sign can
be re-called when selecting a station or repeater call sign.

(default: OFF)

Auto RxCall Reg.
OFF

Auto Reply
OFF

Standby Beep
ON

Scan Timer
T-10
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DD Auto RxCall Disp (Auto RxCall Disp)
� This item appears only when entering set mode from Dig-

ital modes.
When an individual station call is received, the calling station
call sign can be displayed on the RC-24 function display.

(default: ON)

DD Auto MyCall Disp (Auto MyCall Disp)
� This item appears only when entering set mode from Dig-

ital modes.
When operating in a Digital mode, your programmed call sign
can be displayed on the RC-24 function display during trans-
mit. (default: ON)

DD (Extension: Available in RC-24 only)
This item turn expanded set mode ON and OFF.
The expanded set mode includes infrequently changed val-
ues or conditions of functions. When OFF (default) is se-
lected, the following 4 items, key touch beep, dimmer, cooling
fan and auto repeater, are hidden.

DD Key touch beep (Beep)
The key-touch beep for the RC-24 can be turned OFF for
silent operation. (default: ON)

Beep
ON

Extension
OFF

Auto MyCall Disp
ON

Auto RxCall Disp
ON
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DD DV Data Tx (DV Data TX)
� This item appears only when entering set mode from Dig-

ital modes.
Selects the transmission condition for the low-speed data op-
eration from PTT and AUTO.

• PTT : Transmits the entered text when [PTT] is
pushed. (default)

• AUTO : Transmits the entered text when the PC key-
board operation is performed. (The transceiver has
500 msec. carrier sense operation before transmit.)

DD Digital repeater set (Digital RPT Set)
� This item appears only when entering set mode from Dig-

ital modes.
Selects the automatic repeater call sign setting capability dur-
ing digital repeater operation from ON and OFF.

• ON : The call sign that is included in the down-link sig-
nal from the accessed repeater is set into “RPT1”
of the select call sign screen automatically, even
when accessing the repeater with a wrong call
sign setting. (default)

• OFF : The repeater call sign setting won’t be changed.

Digital RPT Set
ONDV Data TX

PTT
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DD Auto message indication
(Auto RxMSG Disp)

� This item appears only when entering set mode from Dig-
ital modes.

Selects the automatic received message indication capability
during digital voice mode operation from ON and OFF.

• ON : Displays and scrolls the message on the RC-24
function display automatically when a short mes-
sage is received. (default)

• OFF : The message can only be displayed when “RX
Message” indication is selected.

DD Dimmer (Dimmer)
Select the RC-24 LCD backlight brightness from bright, dark
and OFF. (default: BRIGHT)

DD Cooling Fan (Fan)
Selects the cooling fan control condition from Auto and ON.

• AUTO : The fan rotates when the internal temperature
of the transceiver exceeds the preset value
until the temperature drops. (default)

• ON : The fan continuously rotates. 

Fan
AUTO

Dimmer
BRIGHT

Auto RxMSG Disp
ON
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DD Auto Repeater (Auto Repeater)

� This item appears only when entering set mode from FM
mode.

The auto repeater function automatically turns ON or OFF the
duplex operation with a specified shift direction and tone en-
coder, when the operating frequency falls within or outside of
1282.000–1295.000 MHz range. The offset and repeater tone
frequencies are not changed by the auto repeater function. If
necessary, reset these frequencies

• OFF : The auto repeater function is turned OFF.
• ON1 : Activates for duplex only. (default)
• ON2 : Activates for duplex and tone.

DD Lock (Available in Set Mode screen only)
Turn the RC-24 lock function ON and OFF.
When “ON” is selected, locks the connected RC-24 key oper-
ation, except [PWR], [ ], [ ], [SQL] and [LOW•3]. (Pushing
[F.INP•L] for 0.5 sec. is possible to release the lock function.)

Auto Repeater
ON1

U.S.A. version only
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� EMR mode operation
The EMR mode is available for Digital voice mode operation.
In the EMR mode operation, no call sign setting is necessary.
When an EMR mode signal is received, the audio (voice) will
be sound in the specified level even the volume setting is set
to counterclockwise position (‘0’ level).

DD Operating from the application
qSet the desired frequency and select either Digital voice

mode.
wClick [EMR], then click [OK] in the appeared confirmation

dialog box to set the transceiver into EMR mode.
• “ ” appears.

eOperate the transceiver normal way.
rTo cancel the EMR mode, click [EMR] again, then click

[OK] in the appeared confirmation dialog box to exit the
transceiver from EMR mode.
• “ ” disappears.EMR

e Appears q Click

w Click

EMR
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DD Operating from the RC-24
qSet the desired frequency and select either Digital voice

mode.
wPush [AFC• •0] for 1.5 sec. (until 3 short and 1 long

beeps sound) to set the transceiver into EMR mode.
• “EMR” blinks.

eOperate the transceiver normal way.
rTo cancel the EMR communication mode, push [AFC•

•0] for 0.5 sec. (until 1 long beep sounds) to exit the trans-
ceiver from EMR mode.
• “EMR” disappears.

LOW

DV
001294.500

EMR

[AFC•        •0]
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� Break-in communication
The break-in function allows you to break into an another sta-
tions communications in both Digital voice and data modes
operation. 

DD Operating from the application
qWhile receiving an another stations communication, set the

either station/repeater call sign into “YOUR” or “RPT1/2”
and your call sign into “MY” in Select Call Sign screen.

wClick [BK].
• “BK” appears.

eWhen both stations are in standby, transmit to send a
break-in call.
• Programmed call sign station receives the break-in call as well

as your call sign.
rWait for the reply call from the station who receive the

break-in call.
tAfter receive the reply call, communicate normal way.
yTo cancel the break-in, click [BK].

• “BK” disappears.

Appears Click

Select/enter the desired call sign
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DD Operating from the RC-24
qWhile receiving an another stations communication, push

[CS• •1] then set the either station/repeater call sign into
“UR” or “RPT1/2” and your call sign into “MY.”

wPush [BK• •.].
• “BK” appears.

eWhen both stations are in standby, transmit to send a
break-in call.
• Programmed call sign station receives the break-in call as well

as your call sign.
rWait for the reply call from the station who receive the

break-in call.
tAfter receive the reply call, communicate normal way.
yTo cancel the break-in, push [BK].

• “BK” disappears.

LOW

DV
001294.500

BK

[BK•        •.]
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� S-meter squelch 
The ID-1 has an S-meter squelch. The S-meter squelch al-
lows you to set a minimum signal level needed to open the
squelch. 

➥ Set [SQL] clockwise past the 12 o’clock position in the ap-
plication (main screen) to activate the S-meter squelch.
• S-meter squelch level can be adjusted between 12 o’clock and

fully clockwise position.
• When setting the squelch from the RC-24, a level greater than

‘19’ activates the squelch attenuator.
• The S/RF meter shows the set level with the reversed indication.

NOTE: The squelch attenuator functions even when the
monitor function is in use. Thus set the [SQL] within 10 to
12 o’clock position (12 to 19 level when setting with the
RC-24) is recommended when using the monitor function.

� AFC function
The AFC (Automatic Frequency Control) function tunes the
displayed frequency automatically when an off-set frequency
is received. It activates in FM and Digital voice modes only.

➥ Click [AFC] in the application (main screen); or push
[AFC• •0] on the RC-24 to turn the AFC function ON
and OFF.
• “AFC” appears when the function ON.

NOTE: The AFC function may not tune the signal properly
when a weak signal is received and/or strong nearby sig-
nals are received.

[AFC•        •0]

ClickAppears

Shows the set level.
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� CPU reset
The function display may occasionally display erroneous in-
formation (e.g. when first applying power). This may be
caused externally by static electricity or by other factors.

If this problem occurs, turn power OFF. After waiting a few
seconds, turn power ON again. If the problem persists, per-
form the following procedure.

IMPORTANT!:
Resetting the transceiver CLEARS all memory information
and initializes all values in the transceiver.

DD Resetting from the application
qSelect “Transceiver Initialization(N)” in the File menu; or

while pressing and holding [Ctrl], press [N] key on the PC
keyboard.
• A confirmation dialog appears.

wClick [OK] to reset the CPU.

DD Resetting from the RC-24
➥ While pushing and holding [V/M] and [CALL], turn power

ON.
• “Memory Clear Wait...” displayed then shows the initial

condition.

Wait...
Memory Clear

[V/M]
[CALL]
[PWR]
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� Troubleshooting If your transceiver seems to be malfunctioning, please check

the following points before sending it to a service center.

PROBLEM POSSIBLE CAUSE SOLUTION REF.
Does not turn on.

No sound comes from the
speaker.

Sensitivity is low and only
strong signals are audible.

No contact possible with
another station.

Repeater cannot be ac-
cessed. 

Frequency cannot be set.

Some memory channels
cannot be selected via the
tuning dial.

• Power connector has a poor contact.
• Polarity of the power connection is reversed.

• Blown fuse.

• Volume is too low.
• Squelch is set too high.
• A selective call or squelch function is activated

such as pocket beep or tone squelch.

• Antenna feedline or the antenna connector has a
poor contact or is short circuited.

• Squelch attenuator function is activated.

• The other station is using tone squelch.
• The transceiver is set to duplex.

• Wrong offset frequency is programmed.
• Wrong subaudible tone frequency is programmed.

• The frequency lock function is activated.
• Priority watch is paused on the watching frequency.

• The memory channel number has not yet been
programmed.

• Check the connector pins.
• Re-connect the power cable observing the proper

polarity. Replace the fuse if damaged.
• Check the cause, then replace the fuse.

• Set the volume to a suitable level.
• Set the squelch level to the threshold.
• Turn the appropriate function OFF.

• Check, and if necessary, replace the feedline or sol-
der the antenna connector again.

• Set squelch between 10–12 o’clock position (appli-
cation) or 12 to 19 level (RC-24).

• Turn the tone squelch function ON.
• Set to simplex.

• Correct the offset frequency.
• Correct the subaudible tone frequency.

• Turn the function OFF.
• Cancel the watch.

• Program the memory channel.

—
pgs. 15,
114
p. 114

p. 34
p. 33
pgs. 92
to 99

pgs. 13,
14
p. 33

p. 92
pgs. 57
, 58

p. 60
p. 59

p. 38
pgs. 90,
91

pgs.
74–76
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Scan does not operate.

The function display shows
erroneous information.

Data communication can-
not be made properly

• The squelch is open.
• Only 1 memory channel is programmed or other

channels are set as skip channels.
• Priority watch is activated.

• The CPU is malfunctioning.

• Ethernet cable has a poor connection.

• Set the squelch to the threshold point.
• Program other memory channels or cancel the

memory skip function in the desired channels.
• Cancel the watch.

• Reset the CPU.

• Re-connect the Ethernet cable.
• Replace the Ethernet cable.

� Fuse replacement
If the fuse blows or the transceiver stops functioning, find the
source of the problem if possible, and replace the damaged
fuse with a new, rated one (FGB 15 A) as shown at right.
The DC power cable has 2 fuses, one each for positive (+;
red) and negative (–; black) line.

15 A 
fuse

PROBLEM POSSIBLE CAUSE SOLUTION REF.
p. 33
pgs. 74
to 76
pgs. 90,
91

p. 112

p. 17
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� Specifications
DD GENERAL
• Frequency coverage : 1240.000–1300.000 MHz
• Type of emission : FM, GMSK (Digital)
• Transmission speed (theoretical value): 

Data 128 kbps 
Digital voice 4.8 kbps

• Codec : AMBE (2.4 kbps)
• Number of memory channels:

105 (incl. 2 scan edges and 3 calls)
• Frequency resolution : 5, 6.25, 10, 12.5, 20, 25, 50,

100 kHz
• Operating temperature range:

–10°C to +60°C; +14˚F to +140˚F
• Frequency stability : ±2.5 ppm (–10˚C to +60°C)
• Power supply requirement: 13.8 V DC ±15%
• Current drain (at 13.8 V DC; approx.): 

Transmit at 10 W Less than 7 A
Receive max. audio Less than 1.5 A

• Antenna connector : Type-N (50 Ω)
• Dimensions (proj. not included):

Main Unit 141(W) × 40(H) × 165.8(D) mm
59⁄16(W)×19⁄16(H)×617⁄32(D) in

Remote controller (RC-24)
150(W) × 50(H) × 49.5(D) mm
529⁄32(W)×131⁄32(H)×115⁄16(D) in

• Weight (approx.) :
Main unit 1.2 kg; 2 lb 10 oz
Remote controller 220 g; 7.7 oz

DD TRANSMITTER
• Modulation system :

FM Variable reactance frequency
modulation

Digital Quadrature modulation
• Output power : 10/1 W
• Max. frequency deviation : ±5.0 kHz (FM)
• Spurious emissions : Less than –50 dB
• Microphone connector : 8-pin modular jack (600 Ω)

DD RECEIVER
• Receive system :

FM, Digital voice Triple-conversion superhetero-
dyne

Data Double-conversion super-
heterodyne

• Intermediate frequencies :
FM, Digital voice 1st: 243.95 MHz, 

2nd: 31.05 MHz, 
3rd: 450 kHz

Data 1st: 243.95 MHz, 
2nd: 10.7 MHz

• Sensitivity (FM: at 12 dB SINAD/Digital: at BER 1×10–2):
FM Less than 0.18 µV
Digital voice Less than 0.35 µV
Data Less then 1.58 µV

• Squelch sensitivity (threshold):
Less than 0.18 µV (FM only)
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• Selectivity (typical) :
FM More than 12 kHz/6 dB

Less than 30 kHz/60 dB
Digital voice More than 6 kHz/6 dB

Less than 18 kHz/50 dB
Data More than 140 kHz/6 dB

Less than 520 kHz/40 dB
• Spurious and image rejection: 

More than 50 dB
• AF output power (at 13.8 V DC):

More than 2.0 W at 10% distor-
tion with an 8 Ω load

• Ext. speaker connectors : 2-conductor 3.5 (d) mm
(1⁄8″)/8 Ω

DD SYSTEM REQUIREMENTS
• Microsoft® Windows® 98/98SE/Me/2000/XP
• An USB port 
• Ethernet port (for Data operation)

� Options
HM-118N HAND MICROPHONES

RC-24 REMOTE CONTROLLER UNIT

MB-17A MOBILE MOUNTING BRACKET

OPC-440/OPC-647 MIC EXTENSION CABLES

OPC-440: 5.0 m (16.4 ft); OPC-647: 2.5 m (8.2 ft)
SP-7/SP-10/SP-22 EXTERNAL SPEAKERS

All stated specifications are subject to change without notice or obligation.
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